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Welcome to Extensis™ P h o t o To o l s™! PhotoTools is a collection
of cre at ivity and pro d u c t ivity tools that enable you to wo rk fa s t e r,
e a s i e r, and more effi c i e n t ly in A d o b e® P h o t o s h o p®.

Building on the success of PhotoTools 1.0 (which was honored to
receive 4 major industry awards), PhotoTools 2.0 responds
primarily to user requests by enhancing the existing tools and
adding important new components. Enhancements include: adding
a much more robust and interactive work environment to the
effects components used to create bevels, glows and embosses;
making the tool for accessing hundreds of Photoshop menu
commands via one-click toolbars even easier to use; and adding
the two most requested features to PhotoText: Styles and support
for text saving and re-editing. And with its two new compo-
nents—PhotoCastShadow and PhotoButton—PhotoTools 2.0
revolutionizes the approach to the common Photoshop tasks of
adding realistic perspective shadows and drop shadows to text and
objects, and creating buttons for web and multimedia applications. 

P h o t o Tools installs its own menu in both the Photoshop menu b a r
and the Fi l t e rs menu , p roviding convenient access to the compo-
nents. All of the tools, i n cluding PhotoBars and PhotoTex t , a n d
the five PhotoEffects plug-ins (PhotoCastShadow, P h o t o B eve l ,
P h o t o G l ow, P h o t o E m b o s s , and PhotoButton) appear in these
m e nu s , along with sub-menus that give you instant access to
common effect settings as well as your own effect settings as yo u
c re ate and save them.

System and Software Requirements

To install and use Extensis PhotoTo o l s , you will need the fo l l ow i n g :

M a c i nt o s h :
• Apple® Macintosh® 68040-25MHz or faster, including

Power Macintosh® and PowerPC compatible
•   3MB free hard drive space
•   Mac OS® System 7.5 or later 
• Adobe Photoshop 3.0.4 or lat e r

Wi n d ow s :
•   Pentium or faster PC 
•   3MB free hard drive space
•   Microsoft® Windows 95® or Windows NT® 4.0
• Adobe Photoshop 3.0.5 or lat e r

Introducing PhotoTools
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We can also be reached by:

Fax: (503) 274-0530

E-mail: support@extensis.com

I n t e r n e t :
h t t p : / / w w w. e x t e n s i s . c o m / s u p p o r t
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Installation

Instructions for installation can be found on the CD-ROM that
came with your product.

Technical Support

For questions regarding Extensis PhotoTools, please first refer to
this manual, which describes the features and basic operations.
We invite you to visit our PhotoTools page on the Extensis web-
site (www.extensis.com) for frequently asked questions and trou-
bleshooting tips.

If you have a question wh i ch is not add ressed in this manual or
on the Extensis web s i t e, Te chnical Support is ava i l able by phone
at (503) 274-7030 Monday through Fri d ay 8:00 a.m. to 5:00
p.m. Pa c i fic time. When calling for technical support, please be at
your computer and have the following information available: your
Extensis PhotoTools registration number, your computer configu-
ration and your question or a description of the difficulty you’re
experiencing—what specifically occurs and when. Take note of
any displayed error numbers or messages and any other informa-
tion you think may be relevant.

Suggestions

We’d love to hear your comments about Extensis PhotoTools! For
your convenience, a suggestion sheet is included at the end of this
manual. Please fax, mail, or e-mail your comments and sugges-
tions to Extensis.

http://www.extensis.com/support


What is PhotoTools?

P h o t o Tools is a collection of cre at ivity and pro d u c t ivity tools that
e n able you to wo rk fa s t e r, e a s i e r, and more effi c i e n t ly in A d o b e®

P h o t o s h o p®.

P h o t o Tools incl u d e s :

• PhotoBars—Makes all menu and sub-menu commands avail-
able as clickable buttons which you access from convenient
toolbars. Toolbars can be moved freely about in the display or
embedded along any edge of the display, and you can rearrange,
add or remove buttons and toolbars instantly. PhotoBars pro-
vides several pre-configured toolbars of commonly used com-
mands; use these or create your own—even add buttons and
toolbars for new filters and plug-ins as you go!

• PhotoText—Gives you the functionality of a full-featured text
layout program right inside Photoshop! Create text, kern/track
for better character spacing, adjust leading for better line spac-
ing, change character width, size, fonts, and colors at will, then
save your style settings for future use. You can even save your
text blocks (including all applied attributes and spacing), then
re-open them later for modification, or for use as-is in other
projects.

• PhotoEffects—Includes four plug-ins for you to use alone or in
combination to quickly create dazzling effects on any image,
including text. Adds a fifth plug-in for creating consistent, styl-
ized buttons such as those used on web pages and in multime-
dia projects. 

With all the PhotoEffects plug-ins, see how your effects look in
real-time and in relationship to
the background and surrounding
objects as you tweak, twist,
blend, and shape using an effect
plug-in’s unique tools to achieve
just the right overall effect.

Change your mind at any time with multiple undos and redos—
even reset your effect and start over from scratch. Save the set-
tings for reuse and easy, one-click application. 
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The PhotoEffects plug-ins include:

• PhotoCastShadow—Create simple drop shadows with one
click, or use any or all of 10 positioning and shaping tools
to interactively skew
shadows to your
desired perspective.
Easily adjust shadow
blur for realistic 3-D
images. Isolate the
shadow on its own layer.
Blend your shadow with
other pixel values in the
target layer. Creating real-
istic shadows has never
been this easy!

• PhotoBevel, PhotoEmboss, PhotoGlow—Create profes-
sional-quality bevels, embosses, and glows. Adjust image
attributes using slider controls or numeric entry fields. Save
settings for future use. And as with all PhotoEffects plug-
ins, see how your changes look as you apply them—watch
your effect’s color change as you move the mouse over the
different colors in the color pop-up window! 

• PhotoButton—Quickly construct beautifully rendered, uni-
form matrices of buttons (such as
those seen on web pages and
in multimedia projects) using
16 pre-defined but completely
customizable shapes. Shape and
color your “anchor” button, then see your effects applied to
all the buttons. Use any combination of rotation angle, cor-
ner radius, inner height, bevel height, width, and curvature;
change surface reflectivity, diffuse angle, and highlight
color, ratio, and direction, to create startlingly realistic 3-D
buttons! 

All PhotoTools plug-ins share a consistent interface, and were
designed and tested to work smoothly with Photoshop versions
3.0.4 and later. We believe you’ll find PhotoTools a natural exten-
sion of Photoshop, and an invaluable tool in your creative arsenal. 

If you have questions, c o m m e n t s , s u gge s t i o n s , or we can help
you in any way, please contact us at our Web site,
h t t p : / / w w w. ex t e n s i s . c o m , or at the location listed on the inside
f ront cover of this User Guide. Contact info rm ation for tech n i c a l
s u p p o rt is given on page 6.
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PhotoBars brings the one-click convenience of toolbar buttons to
Photoshop, giving you instant access to hundreds of Photoshop
commands, tools, and menus. If a menu item or keyboard com-
mand is available inside of Photoshop, from either the Photoshop
application or a plug-in, it can be made available for instant
access on a PhotoBars toolbar.

With PhotoBars, you no longer need to constantly access buried
menus—simply drag buttons containing the commands you use
most often onto a toolbar, and have those commands available in
one click. And if you’re working on a Macintosh, simply enable
SmartBar: SmartBar watches as you select commands, then auto-
matically creates a toolbar for them.

PhotoBars includes several popular preconfigured toolbars to
show you just how convenient toolbars can be. The commands on
these toolbars are ones that most Photoshop users will find useful.
But since work patterns and preferences differ, PhotoBars gives
you the power to customize your toolbars: you can add, remove,
and rearrange buttons according to your preference. You can hide
and unhide your toolbars to re flect your wo rk in diffe rent files and p ro-
j e c t s , and you can have your toolbars “ fl o at ” f re e ly in the Photoshop
window, or “embed” them along any edge of the window—and
instantly change from floating to embedded and back again.

If you find yourself repeating the same commands over and over
again, those commands probably belong on a toolbar. By spend-
ing just a few minutes learning how to work with PhotoBars, you
can save hundreds of steps and drudgery on every project!

PhotoBars

PhotoBars turns this

Into this



10

Tip

Command sub-menus are avail-
able on buttons too! These are
indicated by an arrow ▼ at the
bottom of the button. Just click
and hold the button to access the
pop-down menu.  

Getting Started with PhotoBars

When Photoshop is first opened after PhotoTools has been
installed, the PhotoBars default toolbars will be displayed. The
default toolbars contain preselected buttons, and each button rep-
resents either a Photoshop or a PhotoTools command.

You can start with the default toolbars to rearrange, add or remove
buttons, or to float, embed or hide the toolbars, or even delete
them. And don’t worry—even when you delete a toolbar the com-
mands and buttons used to create them are still available. So you
can recreate a toolbar, or a create a similar one, at any time.

If you’re not interested in using a particular toolbar, simply click
the “close” box to hide it. You can display it again at any time by
selecting “PhotoBars” from the PhotoTools menu, then selecting
the toolbar you wish to display.

To Determine Button Function:

Position the mouse pointer over the button.

The button’s function
will be displayed in the
“Hot Help” pop-up.

Note: You can turn off toolbars Hot Help at any time. Select
PhotoTools > PhotoBars > Edit Toolbars, then click the box
“ S h ow Hot Help” (Macintosh) or “ S h ow To o l Ti p s ” ( Wi n d ow s ) .
No checkmark indicates that Hot Help is turned off.

To Hide a Toolbar:

Click the Close button.
— or —
Select PhotoTools > PhotoBars > Edit toolbars. Select the

toolbar you wish to hide.
— or —
Select PhotoTools > PhotoBars, then select the toolbar you

wish to hide (visible toolbars are indicated with a check).

Typical Floating Toolbar

Close (hide) toolbar



Floating Toolbar
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To Show (Unhide) a Toolbar:

Click the Edit Toolbars button on the PhotoTools
Commands toolbar, then click the toolbar you wish to
show (hidden toolbars have no checkmark).

— or —
Select PhotoTools > PhotoBars > Edit toolbars. Select the

toolbar you wish to show.
— or —
Select PhotoTools > PhotoBars, then select the toolbar you

wish to show.

Floating Toolbars and Embedded Toolbars

Any PhotoBars toolbar can be displayed as either a “floating
palette” toolbar or an “embedded” toolbar.

A floating palette toolbar is a group of buttons that can be moved
to any location on the screen. The advantage of floating palettes
is that they can be dragged anywhere in the screen that’s conve-
nient; they can be reshaped in any combination of rows and
columns; they can be given a name for easy recognition; and they
can be hidden until needed. An embedded toolbar is a row or col-
umn of buttons attached to one side of the window. Embedded
toolbars cannot be resized—but they can be instantly changed to
floating toolbars. The advantage of embedded toolbars is that
they’re at the outside edge of the work area: out of the way, yet
close enough to be accessed quickly.

PhotoBars makes it easy to change back and forth between the
two types, so you can have some toolbars one style and some the
other—and easily switch back and forth between them. 

To Change a Toolbar from Floating to Embedded:

Click in the title bar or empty gray area on the toolbar
(not a button), then drag the toolbar to any edge of the
screen and release.

— or —

Double-click  in the title bar or empty gray area on the
toolbar (not a button). 

The toolbar will automat i c a l ly be embedded in the locat i o n
it was last embedd e d. If it has never been embedd e d, it will
embed to the nearest edge of the window. 

Embedded
Toolbar
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To Change a Toolbar from Embedded to Floating:

Click in either the title bar or the empty gray area on the
toolbar (not a button), then drag the toolbar away from
the edge of the screen. Release the mouse where you’d
like to place the toolbar.

— or —

Double-click  in the title bar or empty gray area on the
toolbar (not a button). 

The toolbar will immediat e ly turn into a fl o ating palette and
placed wh e re it was last positioned as a fl o ating toolbar. If it
was never a fl o ating toolbar, it will be placed in the upper-
left corner of the window.

To Resize (Reshape) a Floating Toolbar:

Drag the toolbar from the grow box in the bottom right
corner (Macintosh) or from the bottom corner
(Windows). Release when the toolbar is the desired
shape.

You can pull the toolbar in any direction to re s i ze it, m a k i n g
it fully ve rt i c a l , f u l ly hori zo n t a l , or anything in betwe e n .

Customizing Toolbars

You can remove buttons, add buttons, add space between buttons
to help group them logically, and move buttons from one toolbar
to another. You may want to create some toolbars for commands
that you use often, and other toolbars for commands that you use
only with certain projects. You can also rename, duplicate, or
remove your toolbars at any time.

To Remove a Button from a Toolbar:

1. While pressing Command (Macintosh) or ALT
(Windows), click and drag the button off the toolbar.
Release the mouse when the button is no longer on the
toolbar.

The icon will disappear.

Note: This action deletes the button icon from the toolbar,
but not from PhotoBars. The button can be retrieved from
the button library at any time (PhotoTools > PhotoBars >
Customize Toolbars). For detailed instructions refer to “To
Add New Buttons to a Toolbar” on page 14.

Drag to reshape
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To Add Space Between Buttons:

1. While pressing Command (Macintosh) or ALT
(Windows), click and drag the button to the left or to
the right only slightly, then release.

Note: It takes just a small amount of movement to add
space between buttons. You may have to experiment a little
to get just the right touch for spacing button icons. 

To Rearrange Buttons On or Between Toolbars:

1. While pressing Command (Macintosh) or ALT
(Windows), click and drag the button to its new loca-
tion, then release the mouse.

You can drag a button to any location on a toolbar, or drag
it to another toolbar (both toolbars must be showing). 

N o t e : If you drag a button around and release it when it is
not positioned over a toolbar, the button will disap p e a r.
Remember that this is how you re m ove a button from a
t o o l b a r, and it can happen accidentally. To re t ri eve the bu t-
t o n , select PhotoTools > PhotoBars > Customize To o l b a rs .
L o c ate the button and drag it back onto your toolbar. Fo r
help see “To Add New Buttons to a Toolbar” on page 14.

To Create a New a Toolbar:

1. Click the Edit Toolbars button on the PhotoTools
Commands toolbar.

— or —

1. From the PhotoTools menu select PhotoBars > Edit
Toolbars.

2. Click “New.”

Tip

You can also create a new toolbar
from the Customize Toolbars dia-
log box—simply drag a button
from the Buttons window to the
Photoshop window.
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3. Enter a name for your toolbar.

4. Click “Done.”

A blank toolbar will be created and placed in the upper-left
portion of the Photoshop window. Drag your new toolbar
to a convenient location.

5. Add buttons to your new toolbar.

Either drag buttons from existing toolbars (the toolbar mu s t
be visible for you to do this), or add buttons from the Cus-
t o m i ze To o l b a rs dialog box (as described in the next section.)

To Add New Buttons to a Toolbar:

1. Click the Customize Toolbars button on the PhotoTools
Commands toolbar.

— or —

1. From the PhotoTools menu select PhotoBars >
Customize Toolbars.

The Customize Toolbars dialog box will appear, showing
all the Categories of available buttons. Each Category rep-
resents a menu in Photoshop. 

2. From the “Categories” window, locate the category of
commands that represents the command you are inter-
ested in.

All the buttons associated with commands in the selected
category will be displayed in the “Buttons” box on the
right hand side of the window.

Tip

Macintosh Users: You can auto-
mate the toolbar creation process
with SmartBar. SmartBar will
“watch” you work and automati-
cally record your commands as
you invoke them, then instantly
create a toolbar of those com-
mands. Refer to “Creating
Toolbars with SmartBar” for more
information.
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3 . From the “ B u t t o n s ” w i n d ow, select the button rep re s e n t-
ing the command that you want to add to your toolbar.

To determine which button represents which command,
pass the mouse over each button. A description of the but-
ton will appear in the “Description” Help box in the center
of the screen (Macintosh) or as a pop-up ToolTip
(Windows).

4 . D rag the button to your toolbar and re l e a s e.

5 . R ep e at steps 1 through 4 for all the commands you wa n t
to add to your toolbar.

If a button doesn’t “land” on the toolbar where you want it,
simply drag it into the correct position. You may want to
add all your buttons first, then experiment with positioning.

Tip

Macintosh Users: You can use
PhotoBar buttons to access files,
folders, and other applications. 

For example, you might want to
create a button that will show you

a pop-up list of
all images in a
particular folder
on your hard
drive. 

To open the
image in
Photoshop,

simply select it from the list. 



Creating New Buttons (Macintosh)

While there are hundreds of predefined buttons available in
PhotoBars (for Photoshop and PhotoTools commands), other
commands that you use frequently may not have a predefined
icon. These might include commands associated with add - o n
fi lters, additional plug-ins, special keyboard functions, etc.
However, if the command is accessible in Photoshop, either by
menu or by key command, you can create a button for it and
access it from a PhotoBars toolbar.

To Create a Button for a New Command (Macintosh):

1. Click the Customize Toolbars
button on the PhotoTools
Commands toolbar.

— or —

1. From the PhotoTools menu, select
PhotoBars > Customize Toolbars.

2. Click “New Button.”

3. Click “Select Icon.”

4. Select an icon for your button.

Scroll through the icons in the icon library and click an
icon to select it.

Note: You can add your own buttons to the icon library.
Refer to “Adding Your Own Button Icons” on page 22.

5. Click “Define.”

This closes the Define Icons dialog, and displays the select-
ed icon in the Edit Custom Button dialog.

Verify that your selected icon appears in the Edit Custom
Button dialog box. 
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Icon selected

Tip

You won’t have to create new but-
tons often—every menu and sub-
menu item in Photoshop, including
Plug-ins and Filters, has a button
already created for it in
PhotoBars. You’ll only need to cre-
ate new buttons to add a button
for third-party Plug-ins, Filters,
etc., or to add a file or folder to
your toolbar(s).

For more information on adding
buttons to a toolbar, see “To Add
New Buttons to a Toolbar,” on
page 14.

Windows Users

Refer to page 23, “Creating New
Buttons (Windows).”
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6. Select “Keystroke,” “Menu,” or “Finder Item.”

If the command you wish to create a button for is invoked
with a keystroke, select “Keystroke.”

If the command appears on a Photoshop menu, select
“Menu.”

If you’re creating a button to access a file, folder, or appli-
cation, click “Finder Item.”

7. Depending on which option you chose, refer to the
appropriate section below.

To Create a Button for a Keyboard Command (Macintosh):

1. If you have not already done so, open the Customize
Toolbars dialog and select an icon as indicated in “To
Create a Button for a New Command” on page 16. 

2. Select the “Keystroke” option. 

3. Click “Select…”

4. Type the keystrokes that invoke your command.

5. Click “OK.”

Verify that your selected keystrokes appear next to the
“Select...” button in the Edit Custom Button dialog box. 

6. Click “OK.”

Your new button will be displayed in the category “Custom
Buttons” in the Categories window of the Customize
Toolbars dialog box.



7. Drag your new button onto a toolbar.

Note: Whether or not you drag your button onto a toolbar,
it will remain in the Custom Buttons category until you
delete it.

8. You can define more buttons, or click “Done” to return
to Photoshop.

To Create a Button for a Menu Command (Macintosh):

1. If you have not already done so, open the Customize
Toolbars dialog and select an icon as indicated in “To
Create a Button for a New Command” on page 16. 

2. Select the “Menu” option. 

A pop-up menu appears to the right of the Menu radio but-
ton. This pop-up allows you to scroll through the menus
until you find the menu item command that you wish to
attach to your custom button.

3. Select the menu command you are creating a button for.

Ve rify that your selected menu command ap p e a rs next to the
pop-up menu button in the Edit Custom Button dialog box. 

4. Click “OK.”

Your new button will be displayed in the cat ego ry “ C u s t o m
B u t t o n s ” in the Cat ego ries window of the Customize To o l b a rs
d i a l og box .

5. Drag your new button onto a toolbar.

Note: Whether or not you drag your button onto a toolbar,
it will remain in the Custom Buttons category until you
delete it.

6. You can define more buttons, or click “Done” to return
to Photoshop.

18
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To Create a Button for a Finder Item (Macintosh only):

1. If you have not already done so, open the Customize
Toolbars dialog and select an icon as indicated in “To
Create a Button for a New Command” on page 16. 

2. Select the “Finder Item” option. 

A dialog appears, asking if you want to attach a file or a
folder to the custom button. 

3. Select “File” or “Folder.”

If you attach a file to the button, the file will be opened
when you click the button. If you attach an application, the
application will be launched when you click the button.

If you attach a folder to the button, folder contents will be
displayed in a pop-up menu when you click the button.

4. Locate the file or folder.

5. If you are selecting a file, highlight the file then click
“Open.” If you are selecting a folder, highlight the fold-
er then click “Select.”

Verify that your selected file or folder appears next to the
“Select...” button in the Edit Custom Button dialog box. 
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6. Click “Done.”

Your new button will be displayed in the category “Custom
Buttons” in the Categories window of the Customize
Toolbars dialog box.

7. Drag your new button onto a toolbar.

8. You can define more buttons, or click “Done” to return
to Photoshop.

Using the SmartBar to Create Toolbars

(Macintosh Only)

SmartBar is a floating palette that automates the task of creating
buttons and toolbars. SmartBar records your menu selections and
commands, then allows you to save those recorded commands as
a toolbar.

When the SmartBar palette is open and enabled, each time you
invoke a menu item or other command it is recorded on the
palette. Up to 15 commands can be shown in the SmartBar palette
at one time. When you’re ready, you can click a button on the
palette and convert those commands into a toolbar. From then on,
instead of selecting commands from pulldown menus, you can
click the buttons to invoke your commands.

To Open the SmartBar Palette (Begin Recording):

1. Click the Show/Hide SmartBar button on the
PhotoTools Commands toolbar.

— or —

1. From the PhotoTools menu choose PhotoBars, then
select Show SmartBar.

Watch Me button
(Toggles SmartBar
on and off)

Build (tool) Bar

Reset Button List

Tip

Note: Whether or not you drag
your button onto a toolbar, it will
remain in the Custom Buttons cat-
egory until you delete it. To delete
an icon from the Buttons window
in the icon library, select (click) it
and press the Delete key.



To Turn SmartBar On or Off (Start or Stop Recording):

1. Once the SmartBar palette is open, you will see the
Watch Me button (the button with the eye on it). Click
this button to turn SmartBar on and off.

When the eye is open, SmartBar watches you
while you work and creates a button for you when
you choose a Photoshop menu command.

When the eye is closed, SmartBar is turned off.

Once SmartBar has created a button for your command and
added it to the palette, you can use the button immediately
by simply clicking on it in the SmartBar list. 

SmartBar lists up to the last 15 commands you have used.
After this, when a new command is added the oldest is
deleted.

To Create a Toolbar from the Commands in the SmartBar:

1. Click the “Build Bar” (hammer) button to create a new
toolbar containing all the buttons listed in the SmartBar
palette.

If you only want some of the listed buttons to be in a new
palette, hold down the Command key and click on the
names (not the icons) of the buttons you want to include in
the new toolbar before you click the “Build Bar” button.

To Copy a Button from the SmartBar to Another Toolbar:

1. Hold down the Command key and drag the button icon
from the SmartBar list to the toolbar you want to place
it in.

To Clear the SmartBar Button List:

1. Click the “Reset List” button in the SmartBar palette.

2. Click OK.

21
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Adding Your Own Button Icons  (Macintosh)

You can cre ate your own icons for toolbar buttons. You can use any
of the icons in the PhotoBars button libra ry, you can use any
Macintosh paint progra m , i n cluding Photoshop, to design your ow n
i c o n s , or you can copy a small image to the cl i p b o a rd and paste it
into the icon libra ry.

To Add a Button Icon to the Icon Library:

1. Create a custom button icon.

Icons that you create should be 19 pixels wide by 17 pixels
tall. Use Copy and Paste (see Note with step 5, below) to
place your icon on the Clipboard. Once a custom designed
icon is on the Clipboard, it can be pasted into the
PhotoBars icon library. PhotoBars will automatically add a
border to your icon, and will alert you if the pasted icon is
not the correct size.

2. Click the Customize
Toolbars button on the
PhotoTools Commands
toolbar.

Or select PhotoTools > PhotoBars > Customize Toolbars.

3. Click “New Button.”

4. Click “Select Icon.”

The Define Icons dialog box appears.

5. Click “Paste.”

Your new icon will be pasted into the icon library as the
last item on the list. 

Note: If you copy your image on to the Clipboard from
Photoshop, you must switch out of Photoshop, then back in,
before the Clipboard will allow you to paste the icon into
the icon library.

6. If you wish to define a button using your new icon, click
“Define.” If you wish to keep your new icon in the
library but do not wish to define a button at this time,
click “Cancel.” If you do not want to keep your new
icon, click “Delete” and then “Cancel.”

Tip

For best results, custom designed
icons should be 19 x 17 pixels
(width x height). 
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Creating New Buttons  (Windows)

While there are hundreds of predefined buttons available in
PhotoBars, other commands that you use frequently may not have
a predefined button. These might include commands associat e d
with add-on fi lters, additional plug-ins, special keyboard func-
tions, etc. If the command is accessible in Photoshop, either by
menu or by key command, you can create a button for it and
access it from a PhotoBars toolbar.

To Create a Custom Button:

1. Click the Customize Toolbars
button on the PhotoTools
Commands toolbar.

— or —

1. In the Edit Toolbars… dialog box click “Customize.”

— or —

1. Select Customize Toolbars… from the PhotoBars sub-
menu of the PhotoTools menu.

The Edit Custom Button dialog box appears.

2. Click the New Button button.

The Icon Button Editor dialog box appears. Custom but-
tons can represent Keystrokes, Photoshop menu items, or
Plug-in items.

3. Click the Keystroke, Menu, or Filter button.

Tip

You won’t have to create new but-
tons often—every menu and sub-
menu item in Photoshop, including
Plug-ins and Filters, has a button
already created for it in
PhotoBars. You’ll only need to cre-
ate new buttons to add a button
for third-party Plug-ins, Filters, etc.

For more information on adding
buttons to a toolbar, see “To Add
New Buttons to a Toolbar,” on
page 14.
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4. Provide PhotoBars with additional information about
the button.

Keystroke: If you selected Keystroke, click in the field
next to “Keystroke” and type in your command. You can-
not use ALT key combinations as these are reserved in
Photoshop.

Menu: If you selected Menu, enter the menu and menu
item numbers corresponding to the desired menu item. The
menu numbers in Windows start counting at 0 for the File
Menu, 1 for the Edit Menu, etc. A pull-down menu is -1.
For example: To select the Image Adjust menu item, you
would enter 2, 2, -1.

Filter: If you selected Filter, click in the Filter Name field
and type in the filter name exactly as it appears on the
menu.

A description of the button command appears in the
Description field. You can edit the button description by
changing the text in this field.

5. Click OK.

The button is added to the Custom Buttons category. You
can add the Custom button to a toolbar, just as you would a
pre-defined button.

Adding Your Own Button Icons  (Windows)

You can cre ate your own icons for toolbar buttons using any
Wi n d ows paint program. 

To Add a Button Icon to the Icon Library:

1. Design an icon in any Wi n d ows paint program. Th e
button must be 19 pixels wide by 17 pixels tall and be a
16-color image.

2. Copy your icon to the Clipboard.

3. Open Photoshop and the Customize Toolbars... dialog.

4. Click New.

5. Define settings for the new button.

6. Click the Button icon on the right side of the dialog
box.

The icon is added to those shown in the dialog box. An
alert box appears if the pasted icon is not the correct size.
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PhotoText is a full-featured character-based text layout plug-in
that adds powerful type capabilities to Photoshop. 

When you open PhotoText, you see a resizable, zoomable preview
of your active layer. When you “apply” your text, PhotoText auto-
matically creates a new layer for it (Photoshop 4.x) or places it as
a floating selection (Photoshop 3.x). 

Inside the Preview window, PhotoText gives you all the tools you
need to enter, manipulate, and position text, including tracking
and kerning, width adjustment, and character styles. You can save
and reapply your styles, and you can save your text blocks and re-
edit them in their original position with all styles intact.

PhotoText

A Text tool: I-beam cursor for creating,
selecting and editing text. Define your
text block while in the Text tool mode
by clicking and dragging the mouse.

B Move tool: Arrow cursor for resizing
or moving text blocks.

C Zoom tool: Click to zoom in. Click
with ALT key to zoom out.

D Hand tool: Allows you to move the
image around in the Preview window.

E Eyedropper: Extracts a color from the
Preview for applying to text.

F Color pop-up: Displays the currently
selected text color. Provides access
to the Photoshop color picker,
Foreground, and Background colors.

G Anti-Alias On/Off: When on, smooths
the edges of text created in larger
font sizes.

H Cursor position: Indicates cursor
position X/Y coordinates on the
screen.

I PhotoText Menu

J Fonts pop-up: Lists available fonts.
The currently selected font name
appears in the box.

K Style: Adjust character style attributes.

L Alignment: Adjust the justification set-
tings of text within the entire text
block: Left, Right, Center and Full.

M Size: Adjust font size of selected text. 

N Leading: Adjust space between lines
of text.

B
C

A

D
E

F

J K L M N O P

R S

Q

G

I

O Track/Kern: Adjust the space between
selected characters.

P Character Width: Adjust the width of
selected characters.

Q Preview window: Displays the text
before you apply it to your image.

R Cancel: Exits the dialog box without
applying the changes.

S Apply: Adds the text in the PhotoText
dialog box to the image in the
Photoshop window. The text is placed
in Photoshop as a floating selection
(v3.0.x) or as a layer (v4.x).

Tip

For a full listing of keyboard short-
cuts, including key commands for
manipulating text, refer to
Appendix A. 

The PhotoText Dialog box  (Windows)

H



Combined with the other PhotoTools plug-ins, you can shape,
shade, and manipulate your text to create really professional
effects with much less effort than ever before.
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A Text tool: I-beam cursor for creating,
selecting and editing text. Define your
text block while in the Text tool mode
by clicking and dragging the mouse.

B Move tool: Arrow cursor for resizing
or moving text blocks.

C Zoom tool: Click to zoom in. Click
with Option key to zoom out.

D Eyedropper: Extracts a color from the
Preview for applying to text.

E Color pop-up: Displays the currently
selected text color. Provides access
to the Photoshop color picker,
Foreground, and Background colors.

F Anti-Alias On/Off: When on, smooths
the edges of text created in larger
font sizes.

G Cursor position: Indicates cursor
position X/Y coordinates on the
screen.

H Fonts pop-up: Lists available fonts.
The currently selected font name
appears in the box.

I Style: Adjust character style attributes.

J Alignment: Adjust the justification set-
tings of text within the entire text
block: Left, Right, Center and Full.

K Size: Adjust font size of selected text. 

L Leading: Adjust space between lines
of text.

M Track/Kern: Adjust the space
between selected characters.

C

A

D
E

I J K L M N O

S T

P

F

H

N Character Width: Adjust the width of
selected characters.

O Styles pop-up: Create, edit, and apply
custom Style Settings. 

P Preview window: Displays the text
before you apply it to your image.

Q Open: Open a saved text block file.

R Save: Save text blocks for reuse.

S Cancel: Exits the dialog box without
applying the changes.

T Apply: Adds the text in the PhotoText
dialog box to the image in the
Photoshop window. The text is placed
in Photoshop as a floating selection
(v3.0.x) or as a layer (v4.x).

Q R

The PhotoText Dialog box  (Macintosh)

B

G
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Getting Started with PhotoText

To Open the PhotoText Preview window:

1. In Photoshop, select the layer you wish to view in the
PhotoText Preview window. If you want to create text
without a background, open a new file in Photoshop,
then open PhotoText.

PhotoText will use the selected layer as a background so
that you can see how your text images relate to the back-
ground image. Your text will not be added to the back-
ground—PhotoText automatically creates a new layer for
text.

2. Click the PhotoText button on the
PhotoTools Commands toolbar.

— or —

From the PhotoTools menu in the menubar (or in the
Filters menu), select PhotoText.

The PhotoText Preview window and dialog box will open.

3. Create as many text blocks as you like, and adjust the
text in them using the tools provided. You can create
and save style settings and save your text blocks for
later use.

To Create a Text Block:

1. Select the Text tool.

2. Click anywhere in the PhotoText Preview window, then
begin typing.

You can also cl i ck and drag to define a text bl o ck with ex a c t
bounding bord e rs , then release the mouse and begin typing.

For precise text bl o ck positioning, use the cursor coord i n at e
i n fo rm ation displayed on the left side of the dialog box .

N o t e : If you don’t see all the letters as you type them, u s e
the A rrow tool to select the text box , then drag the handles
to enlarge it.

Tip

To create a composite Preview of
all your active layers in PhotoText,
open the Photoshop 4.0 Layers
Palette, then press Command+
Option+ Shift+E (Macintosh) or
Control+ALT+ Shift+E (Windows)
to create the composite layer.
Make this layer the active layer,
then open PhotoText. When
you’ve finished creating and
applying your text (the text will be
on a separate layer) simpy delete
the composite layer.
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To Add Text from Another Application:

1. In the other application, select the text to be added,
then copy the text to the clipboard.

Choose Copy from the Edit menu, or press Command+C
(Macintosh) or Control+C (Windows).

2. Open Photoshop.

3. Open PhotoText. 

Select PhotoText from the PhotoTools Commands toolbar,
from the PhotoTools menu in the menubar, or from the
PhotoTools menu in the Filters menu.

4. Select the Text tool, then click anywhere in the
PhotoText Preview window, or use the Text tool to posi-
tion the insertion point in an existing text block.

5. Paste your selection.

Choose Paste from the Edit menu, or press Command+V
(Macintosh) or Control+V (Windows) .

To Move a Text Block:

1. Select the “Arrow” tool in the PhotoText dialog box.

2. Click the text box to select it, then drag it to its new
position.

To Manipulate Text:

You can select text using the Text tool, or you can use the Arrow
tool to select an entire text box.

1. Select the “Text” tool in the PhotoText dialog box.

2. Select the text you want to change.

3. Use the tools in the PhotoText dialog box to modify the
appearance of the text.

— or —

1. Select the “Arrow” tool in the PhotoText dialog box.

2. Select the text block(s) you want to modify.

3. Use the tools in the PhotoText dialog box to modify the
appearance of the text.

Tip

While the Text tool is active, hold
down the Option key (Macintosh)
to temporarily change to the Arrow
tool. 

Press Command-Tab (Macintosh)
or Control-Tab (Windows) to tog-
gle between the Arrow and Text
tools.

Tip

Since PhotoText puts text on its
own layer, you will be able to posi-
tion the text in Photoshop even
after applying the changes made
in PhotoText. However, since all of
your text is on the same layer, you
will not be able to move the text
blocks individually, as you can in
PhotoText. For greatest flexibility,
either do all your text positioning
in PhotoText, or create logical lay-
ers of text, grouping types of text
that will maintain a spatial relation-
ship.

Tip

For best results, turn off Anti-
Aliasing when working with text
smaller than 14 points.
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To Save Text for Re-editing in PhotoText:

PhotoText allows you to save your text for reuse or editing. On
Macintosh, you can save one, many, or all text blocks in one file.

1. Use the Arrow tool to select the text blocks that you
wish to save.

If you don’t select any text blocks, PhotoText will save all
the text blocks.

2. Select File > Save from the PhotoText menu in the
menubar.

— or —

Press Command+S (Macintosh) or Control+S
(Windows).

— or —

(Macintosh) Click the “Save” button in the PhotoText
dialog box.

You will be prompted to enter a name for the saved fi l e. 

3 . Enter a name for your saved tex t
fi l e. 

Your text bl o ck(s) will be saved with
all the at t ri butes assigned to them,
including their location on the page.

PhotoText will name the saved file
“PhotoText.stb” (Macintosh) or
“PhotoText.ptx”(Windows) unless
you specify a different name.

To Open Text Saved in PhotoText:

Note: PhotoText allows you to open only one saved text file in
each session. When you open a saved text file, the saved text will
overwrite any text blocks you have created during the session. If
you wish to have a number of text elements available for reuse or
editing, either create separate layers for them, or save all the
blocks together in the same Saved Text Blocks file (Macintosh) or
PhotoText file (Windows).

1. Open PhotoText.

Click the PhotoText button on the PhotoTools toolbar, or
select PhotoTools > PhotoText from the menubar.

PhotoText 
Saved Text Icons

Mac

Win

Note

On Windows, all text blocks are
saved when Save text is selected. 
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2. Select “Open...” from the PhotoText menu in the
Photoshop menubar.

— or —

Press Command+O (Macintosh) or Control+O
(Windows).

— or —

(Macintosh only) Click the “Open” button in the

PhotoText dialog box.

3. Locate the file you wish to open, then click Open.

Your text will be displayed in the PhotoTools Prev i ew window.

To Save Text for Use in Another Application:

Note: Not all attributes are saved on export.

1. Select the text block(s) using the Arrow tool.

2. Choose “Export As Text…” (Macintosh) or “Export...”
(Windows) from the “PhotoText” menu in the menubar.

Your text will be saved as a SimpleText document
(Macintosh) or text document (Windows) on your hard
drive.

To Apply Text to a Photoshop Image:

1. When the text in the PhotoText Preview window
appears as you want it, click the Apply button, or press
Enter or Command+P (Macintosh) or Control+I
(Windows).

Your text will be returned as a floating selection in
Photoshop 3.x, and as a layer in Photoshop 4.x.

Tip

To apply text to the active layer
instead of creating a new layer
(Photoshop 4.x) or floating selec-
tion (Photoshop 3.x), press Option
(Macintosh) or ALT (Windows)
when you Apply the text.

Windows Users: You can also
choose the menu item PhotoText >
Apply Direct from the menubar.

Tip

Photoshop 3.0.x: After PhotoText
has returned a floating selection,
you can convert the selection to a
new layer by choosing the
Photoshop New Layer option
while the selection is still active.
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Adjusting Text Attributes

When the PhotoText preview window is opened, a new set of text
menus becomes available and include Save and Open options that
allow you to save text blocks—including all of their attributes—to
a file and open it for re-editing or reuse later. Combined with
type-in fields directly in the Preview window, numerous keyboard
commands for manipulating text (see Appendix A), and the ability
to create and save Style Settings, PhotoText gives you the flexibil-
ity to experiment with type attributes using whatever method
works best for you. 

Note: PhotoText remembers the last-used font and most of the
last-used text attributes when creating a new text block and when
PhotoText is reopened for a new session.

A C

F G

When the PhotoText dialog box is
opened, special text editing menus
become available. These menus pro-
vide a familiar text-editing environment.

A PhotoText: This is the first PhotoText
menu, appearing in the left-most cor-
ner of the menu bar (where the FIle
menu typically appears). Use this
menu to access the Save and Open
text block commands.

B Edit: Access typical editing com-
mands such as Cut, Copy, Paste,
Select All, and Undo.

C Window: Zoom in and out of the
PhotoText Preview window.

D Style: Select and Save Style settings
for future use. On Windows, this
menu appears in the menubar. On
Macintosh, this menu appears as a
pop-up menu above the Preview win-
dow.

E Font: Provides access to all fonts cur-
rently available to the system. 

F Text: Provides attributes for character
size, style, and justification.

G Spacing and Width: Adjusts character
spacing and width.

PhotoText Menus

Tip

You can change most text attribut-
es on individual characters or the
entire text block. Use the Text tool
to make changes on a character
level, or use  the Arrow tool to
make changes to the entire text
block.

B D

E
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Tip

To adjust the space between two
characters (kerning), position the
insertion point between the two
characters, then adjust the value
in the Track/Kern field.

To Create a Style Setting from Styled Text:

1. Open PhotoText.

Click the PhotoText button on the
PhotoTools toolbar, or select
PhotoTools > PhotoText from the
menubar.

2. Create some text and apply the attributes to the text
that you wish to include in the Style Setting.

3. Use the Text tool to drag-select the text you want to
base the Style Setting on, or use the Arrow tool to click-
select a text box.

4. Select “Add Styles…” from the Style pop-up
(Macintosh) or menu (Windows).

The attributes for the selected text will be displayed in the
attribute boxes in the Edit Character Styles dialog box.
Sample text at the bottom of the window shows how text
will look with the selected style applied.

5. Enter a name for the new Style.

6. Make any last-minute changes to the Style using the
text attribute options.

7. When you are ready to save your new Style Setting,
click “OK.”
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To Create a Style Setting from the Edit Styles Dialog:

1. Open PhotoText.

Click the PhotoText button on the PhotoTools toolbar,or
select PhotoTools > PhotoText from the menubar.

2. Select “Edit Styles…” from the Style pop-up
(Macintosh) or menu (Windows).

3. Click “New” to create a new Style Setting.

— or —

3. Select a style from the list, then click “Duplicate” to
duplicate an existing style setting.

4. Enter a name for the Style.

5. Click “Done.”

Your new Style will be saved and can be accessed from the
PhotoText Styles pop-up menu and reapplied at any time.

To Rename a Style:

1. Open PhotoText.

Click the PhotoText button on the PhotoTools toolbar,or
select PhotoTools > PhotoText from the menubar.

2. Select “Edit Styles…” from the Style pop-up
(Macintosh) or menu (Windows).

3. Select a style from the list, then click “Rename.”

4. Type in the new name.

5. Click “OK.”
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To Edit a Style:

1. Open PhotoText.

Click the PhotoText button on the PhotoTools toolbar,or
select PhotoTools > PhotoText from the menubar.

2. Select “Edit Styles…” from the Style pop-up
(Macintosh) or menu (Windows).

3. Select a style from the list, then click “Edit.”

4. Use the buttons, pop-up menus, and parameter boxes to
change style attributes, or enter a new name for the
Style.

5. Click “OK.”

To Apply a Style:

1. Open PhotoText.

Click the PhotoText button on the PhotoTools toolbar,or
select PhotoTools > PhotoText from the menubar.

2. Select the text or text block you wish to apply the style
to.

You can select individual characters, words, etc. using the
Text tool, or select one or more text boxes using the Arrow
tool.

3. Select a Style Setting from the Style pop-up (Macintosh)
or Style menu (Windows).

The selected style will be applied to the text.
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PhotoEffects is a set of five image-enhancement tools for
Photoshop, allowing you to create spectacular Photoshop effects
in a fraction of the time it used to take, and with much more inter-
active control. The five Effects plug-ins are:

• PhotoCastShadow •  PhotoBevel •  PhotoGlow
•  PhotoButton •  PhotoEmboss

Using these tools you can create professional effects on any type
of graphic element, including text (except PhotoButton), with sig-
nificantly less effort. See the results of your actions interactively
as you tweak, twist, color, and distort to achieve just the right
effect. When you’ve achieved the result you want, apply it to your
image. You can even save your favorite effect settings and recall
them for use on other images.

PhotoCastShadow: Interactively create drop shadows and cast
perspective shadows with realistic adjustable 3-D blurs, and see
your work in a real-time preview.

PhotoButton: Interactively create up to 64 beautifully rendered
identical buttons using an array of tools to modify and customize
button shape, size, and color.

PhotoBevel, PhotoEmboss, PhotoGlow: Create custom bevels,
embossing, and glow effects on any image, in a fraction of the
time it would take to achieve them manually.

All PhotoEffects plug-ins (except PhotoButton) include a handy
pop-up image navigator, editing in real time with interactive pre-
view, multiple undos, and the ability to view composite layers
(Photoshop 4.0.x)—so you can see exactly how your effects will
fit with the background and other image elements. Whether used
individually or together, the PhotoEffects plug-ins will g ive you
professional buttons, shadows, bevels, embossing, and glows with
a minimum of effort.

PhotoEffects
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Elements Common to All Effects

Many commands and attributes are common to all five Effects
plug-ins (PhotoButton, PhotoCastShadow, PhotoBevel,
PhotoEmboss, and PhotoGlow). Those common operations are
described in this section. For specific details about each of the
individual plug-ins, refer to the section in this manual specific to
that effect.

All PhotoEffects plug-ins provide the following:

• Image preview—work with any image or selected part of an
image. Experiment until you achieve just the right effect, then
“apply” that effect to your image.

• Interactive, real-time editing environment—work with effects
interactively, watching your effect take shape on a real-time
Preview screen.

• Multiple undos and redos—go back and forth as many steps as
you need to before applying your effect to the image.

• View composite layers (Photoshop 4.x only)—see all the active
layers, not just the layer you’re working on, inside the plug-in
Preview window. Allows you to see your effects in relation to
the rest of the image without giving up the flexibility of layers.

• Photoshop 4.x Actions Palette aware—allows for easy Actions
Palette scripting inside Photoshop. Dramatically increases pro-
ductivity when you need to create the same effects in multiple
files.

• Navigator pop-up—innovative “pop-out” navigator is hidden
until needed. Allows you to instantly position your image in the
Preview window without competing with the image for space.

• Standard Photoshop-style interface—no need to relearn tools
and commands. All PhotoEffects plug-ins use many Photoshop-
type commands, and operations behave as you’d expect them to
if applied directly in Photoshop (exceptions are noted where
they occur.) Zoom and scrolling controls use standard keyboard
shortcuts (see Appendix A).

• Save and reapply effects—create just the effect you want, then
save the settings for reuse at any time.

• Eyedropper tool—extract colors from the image without leav-
ing the Preview window.

• Background processing—uses idle time between image adjust-
ments to process the effect, reducing or eliminating the need for
more processing when the effect is applied.

• Fit on Preview—fits the image to the available Preview win-
dow. Equates to Photoshop Fit on Screen command.

• Help Box—displays, in a special window, a description of each
tool and button function as you drag the mouse over it.

Tip

For a full listing of keyboard short-
cuts, including key commands for
manipulating text, refer to
Appendix A.
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Getting Started with PhotoEffects

To create an effect using a PhotoEffects plug-in:

1. Select an area of your image where you wish to add an
effect.

Note: PhotoCastShadow and PhotoGlow require that an
image area be selected, either implicitly (using a layer’s
transparency mask) or explicitly (“marching ants” indicat-
ing the selected area). PhotoButton, PhotoBevel, and
PhotoEmboss do not (see page 44 for a discussion of
implicit and explicit selection).

If yo u ’re not familiar with cre ating effects using a plug-in,
s t a rt with something simple. Open your image in Photoshop,
and using the Marquee tool, d rag a rectangle around the are a
you wish to work with, or create a layer with the image
yo u ’ll be wo rking on (try cre ating some text in PhotoTex t ! ) .
If no area is selected, the PhotoEffect plug-ins assume yo u
want to work with the full image (see Note above).

2. Select the desired PhotoEffect plug-in.

Select a plug-in from the PhotoTools Commands toolbar,
f rom the PhotoTools menu in the menu bar, or from the
P h o t o Tools menu in the Photoshop Fi l t e rs menu .

Select PhotoCastShadow, PhotoButton, PhotoBevel,
PhotoEmboss, or PhotoGlow. The Preview window dialog
box for the selected Effect will be displayed.

3. Use the options in the effects Preview dialog box to cre-
ate the desired effect (the specific options for each effect
are described later in this chapter). 

Tip

If you’re working with a floating
selection and wish to preview it
with the background image,
choose “Defloat” (Command+J,
Macintosh or Control+J, Windows)
from the Photoshop Select menu
before opening the Effect plug-in.
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Inside each of the PhotoEffects plug-ins you can exper i-
ment with all kinds of effect parameters, and immediately
see your result on the image in the Preview window.

Note: While you are working in an Effect’s dialog box
(Preview window) the changes you make do not affect the
image in Photoshop. When you like the effect you see in the
Preview window and are ready to make those changes to
your image, click “Apply.” Until you click “Apply” you
can change the parameters as much as you like until you
get just the effect you want. If you don’t like the effect you
created, click Cancel and the Effect’s window will close
without making any changes to your image.

If your changes don’t appear in the Preview window, see
“Unexpected Results” later in this chapter.

5. When you’re satisfied with the effect you’ve created in
the Preview window, apply the effect to your image.

Click “Apply” to add the effect to your image.

If you get any wa rning dialogs when you attempt to ap p ly
your ch a n ge s , re fer to “ U n expected Results” and “A dd i t i o n a l
I n fo rm at i o n ” l ater in this ch ap t e r.

Note: If you accidentally Apply the effect to your image
before you are completely finished (the Effect dialog box
closes), you can “undo” the effect (Command+Z, M a c i n t o s h
or Control+Z, Windows). You can then reopen the Effect—
it will remember and display your Last Used settings.

To Save PhotoEffects Settings for Later Use:

1. Once you’ve established the settings exactly as you
want them, click the “Save” button in the Effect’s dia-
log box.

A Save dialog box appears, allowing you to name and save
the current Effect’s settings as a filter.

2. Type a name for the Settings to be saved.

3. Click “OK.”

The name of the Settings will appear in the pop-up menu
in the bottom-left corner of the dialog box. It will also be
available from the Effect plug-in’s submenu on the
PhotoTools menu, and from the Settings button pop-down
menu for the associated Effect, if you have you have this
button installed on a PhotoBars toolbar (Macintosh). 

Tip

Macintosh Users:PhotoBars
provides another convenient way
to access effect settings saved in
the PhotoEffects plug-ins: Click
the Saved Effects button in the
Effects Settings toolbar to see a
list of all saved effect sets. 

Tip

You can apply a saved effect by
selecting it in the Effect’s dialog
box or by selecting it in the
PhotoTools menu. When you
choose a Setting from a menu,
the effect is immediately applied
to the selection, without opening
the Effect’s dialog box.
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To Use PhotoEffects Settings Previously Saved:

1. Select an area of your image on wh i ch to ap p ly the effe c t .

2. Open the desired PhotoEffects plug-in.

3. Select the name of the saved effect from the Settings
pop-up menu in the bottom-left corner of the dialog box .

N o t e : Settings are specific to the plug-in they we re save d
in. For ex a m p l e, you cannot open PhotoCastShadow set-
tings in PhotoBeve l.

4. If desire d, m a ke any additional adjustments to the effe c t .

5. Click “Apply” to add the effect to your image.

— or —

1. Select an area of your image on wh i ch to ap p ly the effe c t .

2. Select the saved Settings you wish to use from the Effect
plug-in’s submenu on the PhotoTools menu.

The saved effect will be applied to the selection
immediately, without opening the Effect’s dialog
box. 

You can also (Macintosh only) select Settings
from the Settings button pop-down menu for the
associated Effect, if you have this button
installed on a PhotoBars toolbar.

To Delete PhotoEffects Settings Previously Saved:

1. Select the desired PhotoEffects plug-in.

2. L o c ate the setting you want to delete in the Settings pop-
up menu in the bottom-left corner of the dialog box .

3. Click “Delete.” You will be asked to confi rm the deletion.

4. Click “OK.”

Preset Settings
A number of common effect Settings are provided for each of the
Effect plug-ins. These Settings can be used “as is” or selected and
then modified. The Preset Settings cannot be removed.

To Select a Preset Setting:

1. Follow the steps in “To Use PhotoEffects Settings Pre-
v i o u s ly Save d ” ( ab ove). The Preset Settings appear in the
upper-half of the menu, above any user-created settings.



Common Elements Explained

The PhotoEffects Dialog Box

When you select a PhotoEffects plug-in, the dialog box for that
plug-in is opened. Inside this window you have access to all the
tools, options, and windows needed to create, modify, experiment
with, and view your effect. For details about the tools and options
available for the different Effects, refer to the section of this man-
ual specific to that Effect. 
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A PhotoEffects Menus: In Windows, the
Effects menus are located at the top
of the dialog box window. In
Macintosh, the menus replace the
Photoshop menus in the main
menubar

B Title Bar: Shows the PhotoEffects
plug-in currently in use.

C Preview window: Displays your image
with the selected effects applied
before you apply them to your image.
Updates your changes in real time if
“Real-time Preview” is turned on.
Displays the composite view of all
selected layers when “View
Composite Layers” is turned on.

D Image Navigator: Click and drag in
this pop-up window to instantly reposi-
tion the image in the Preview window.

E Effect-specific Options: These effects
options will differ depending on what
PhotoEffects plug-in is being used.

F Settings: These tools allow you to
Select, Save, and Delete effect set-
tings. Only settings appropriate to the
current PhotoEffects plug-in will be
available in the list. 

G Help Box: Describes each  function as
the mouse passes over it.

H Undo/Redo/Reset: Undo/Redo pro-
vides multiple undos and redos;
Reset returns all settings to their
default values (useful for starting over
“from scratch”). 

I Zoom Controls and Indicator:
Changes and displays zoom amount.

J Progress Indicators: Top bar shows Preview Redraw progress. Bottom bar shows
Background Processing progress when the “Background Processing” option is
turned on.

K Effect-specific Tools: These tools may differ depending on what PhotoEffects plug-in
is being used. Scroll (Hand) and Zoom (Magnifiying glass) are available in all
Effects.

L Cancel/Apply: Apply closes the dialog box and applies your effects to the image in
Photoshop. Cancel closes the dialog and leaving the image unchanged. 

B C D

E

F

LG I J KH

Typical PhotoEffects Dialog box

A
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Undo/Redo/Reset
All of the controls in PhotoEffects provide multiple undo and
redo capability using the Undo/Redo buttons in the Effect’s dialog
box, selecting Undo/Redo from the menu, or using keyboard
shortcuts. Reset returns all settings to the default condition, allow-
ing you to start over in a known state.

To Undo a Command:

1. Click Undo as many times as needed to undo steps. 

Or select Undo from the Edit menu. Or press Command+Z
(Macintosh) or Control+Z (Windows).

The Undo button is grayed out if there are no operations to
undo.

To Redo a Command:

1. Click Redo as many times as needed to restore previous
undo(s).

Or select Redo from the Edit menu. Or press Command+Y
(Macintosh) or Control+Y (Windows).

The Redo button is grayed out if there are no operations to
redo.

To Reset all Effects:

1. Click Reset.

All effect settings, undos, and redos for the current session
will be restored to factory defaults. The Preview image will
be displayed with no other effects applied.

Tip

You can “undo” a Reset.
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View Composite Layers (Photoshop 4.0.x only)

With the View Composite Layer feature you can see all visible
layers—not just the layer you’re working on—inside the Effect
Preview window. This a l l ows you to see your effects in re l ation to
the rest of the image without having to fl atten the laye rs .

To View Multiple Layers in a PhotoEffects Preview:

1. In Photoshop, verify that all the layers you want to see
in the image Preview window have been made visible
(eye icon showing in the layers palette).

2. Select the image area that you wish to create an effect
for.

3. Select the PhotoEffects plug-in for the effect you wish to
create.

This opens the plug-in Preview window dialog box. You
should see all the layers along with your image.

4. If you do not see the layers along with your image,
choose View > View Composite Layer.

This enables the Vi ew Composite Layer function. (Th i s
option is turned off by default when PhotoTools is
i n s t a l l e d.) Or press Command+L (Macintosh) or Contro l + L
( Wi n d ow s ) .

Note: If the image does not appear to preview correctly after per-
forming the steps above, see Additional Infor-mation on page 48
and Unexpected Results on page 51.

Fit on Preview

Fit on Preview adjusts the zoom percentage to the largest size that
can fit in the Preview area and still contain the entire image.
Actual Pixels re t u rns the Prev i ew to the actual pixel size prior to
i nvoking Fit on Prev i ew.

To Fit the image to the Preview window:

1. Select View > Fit on Preview.

Or press Command+0 (Macintosh) or Control+0
(Windows).

Tip

You can toggle View Composite
Layer on and off from inside the
Effect’s Preview window with
Command+L (Macintosh) or
Control+L (Windows).



Real-time Preview

The Real-time Preview feature allows different effects to be
applied and viewed as you change them. This means you get
immediate feedback in your preview as you adjust the parameters
of an effect. 

One of the most striking examples is in the Color Pa l e t t e. In a typi-
cal progra m , you would cl i ck-open the Color Pa l e t t e, choose a
c o l o r, release the pop-up, then wait for the prev i ew to display the
e ffect in that color. To try a diffe rent color, you would have to go
t h rough the whole color-selection process again. With the Effe c t s
p l u g - i n s , you simply cl i ck-open the palette and drag the mouse
over the color chips. Each time you drag the mouse over a diffe r-
ent color ch i p , the prev i ew updates immediat e ly in real time. 

For example, with Real-time Preview on, if you are creating a cast
shadow and want to experiment with shadow coloring, press and
hold the Color Palette pop-up as you drag the mouse around—the
Preview image immediately shows the shadow in the color you
chose, and the shadow color will change as you drag your mouse
over the different colors. Try turning Real-time Preview off and
see the difference!

Note: You can also preview colors interactively by selecting the
Eyedropper and dragging it around the Preview window.

To Turn Real-time Preview On or Off:

1. Choose Options > Real-time Preview.

A checkmark indicates that Real-time Previewing is On.

Whether or not you have Real-time Previewing turned on, the
Preview image must be processed and redrawn when you change
an effect option. This redraw is tracked on the top half of the dual
progress bar located just underneath the Preview window. The
Preview is not completely finished until the progress bar reaches
the end.
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Preview
processing progress
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Background Processing

In a typical Preview scenario, when you are finished with preview
mode and want to apply your changes to the image, more process-
ing is required before the image window reappears. To speed
things up, PhotoEffects uses the idle time between your image
adjustments in the Preview window to begin final processing. As
soon as you stop adjusting controls, final processing begins, and a
progress bar is displayed just below the Preview window. If the
progress bar is complete (indicating that processing is complete)
when you Apply the effect, the image screen will appear much
more quickly.

To Turn Background Processing On or Off:

1. Choose Options > Background Processing.

A checkmark indicates that Background Processing is On.

Note for Photoshop 3.0.x: In Photoshop 3.0.x, background pro-
cessing works only on implicit selections, not explicit selections.
A selection is implicit when a layer’s transparency mask is used
to indicate the selection area. A selection is explicit when the
selected image is surrounded by “marching ants.” If the selection
was explicitly selected, the PhotoEffects plug-ins will not process
effect changes in the background even if this option is enabled.

Image Implicitly Selected
(Isolated on a layer)

Image Explicitly Selected
(Indicated by “marching

ants” outlining the selection)
No background processing

in Photoshop 3.0.x.

Background processing
progress



Zooming and Panning

All PhotoEffects plug-ins provide a number of easy ways for nav-
igating and viewing effects in the Preview window.

To Zoom In:

Click the “+” button under the Preview window.

Each click magnifies the image to the next percentage.
Zooming occurs from the center of the image. When you
reach maximum magnification, the center of the Zoom tool
appears empty.

— or —

Select the Zoom tool (magnifying glass), then
click the area of the image you want to magnify.

Each click magnifies the image to the next percentage, and
the magnified display is centered around the point you
click. 

— or —

Press Command+Shift+“+” or Command+Keypad “+”
(Macintosh) or Control+Keypad “+” (Windows).

— or —

Choose Edit > Zoom In from the menubar.

To Zoom Out:

Click the “–” button under the Preview window.

Each click reduces the image to the next percentage.
Zooming occurs from the center of the image. When you
reach maximum reduction, the center of the Zoom tool
appears empty.

— or —

Select the Zoom tool (magnifying glass). While p re s s i n g
Option (Macintosh) or A LT ( Wi n d ow s ) , click the
area of the image you want to reduce.

Each click reduces the image to the next percentage.

— or —
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Zoom In

Zoom Out

Tip

Macintosh Users: To momentarily
switch to the Hand tool, hold down
the Spacebar.

To momentarily access the Zoom
tool when the Hand tool is active,
press Command (Zoom In) or
Option (Zoom Out).

Note: These commands work
together: With any tool selected,
press Spacebar to activate the
Hand tool, then also press
Command or Option to access a
Zoom tool.

Tip

Double-click the Zoom tool to
zoom to 100%. 
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Tip

Double-click on the Hand tool to
force the Preview image to fit the
available window (Fit on Preview). 

Press Command+Shift+“–” or Command+Keypad “–”
(Macintosh) or Control+Keypad “–” (Windows)

— or —

Choose Edit > Zoom In from the menubar.

To Pan (Scroll) in the Preview Window:

Select the Hand tool and drag the image until you
locate the area you wish to view.

— or —

With any other tool selected (Macintosh only), press
Spacebar while you drag the image in the window.

Navigator Pop-up

This handy little navigator window “pops-out” from the upper-
right corner of the Effect’s Preview window (except PhotoButton),
allowing you to instantly reposition your image within the win-
dow. The navigator stays out of the way until you need it, but is
instantly available when you do.

To Use the Effect’s Preview Window Navigator:

1. Click and hold the mouse over the Navigator button in
the upper-right corner of the Preview window.

2. Keep holding the mouse button down as you drag the
view box around the Navigator window.

3. When the image area you want to see appears in the
Preview window, release the mouse to close the pop-up.



Color Tools

Color Pop-up: Provides interactive access to the current Color
Palette, the current Photoshop Foreground and Background col-
ors, and the Color Picker. Color values are shown on the right
side of the palette, reflecting both the current Color Mode (RGB,
CMYK, etc) and the color values of the highlighted color.

Note: In RGB mode, the Color pop-up displays all and only
“web-safe” colors. This does not mean that the final result color
will be web-safe, since colors may sometimes be blended and/or
faded to the background.

Note: None and Transparent are PhotoButton only parameters
and will be grayed out in the other PhotoEffects plug-ins. For
information on these selections refer to the PhotoButton section
of this manual.

To Preview Colors Interactively Using the Color Pop-up:

1. Click and hold on the color indicator box.

2. Drag the cursor over the color swatches in the window
and observe the changes in the effect’s color.

Eyedropper: Provides interactive access to colors in the Preview
window.

To Preview Colors Interactively Using the Eyedropper:

1. Select the Eyedropper tool.

2. Drag the Eyedropper around in the Preview window
and observe the changes in the effects’ color.

To Select a Color Using the Eyedropper:

1. Select the Eyedropper tool.

2. In the Preview window, click the Eyedropper on the
color you wish to select.

The selected color will appear in the color box.
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Additional Information

This section details some of the more intricate features of the
PhotoEffects plug-ins. If you’re already familiar with Photoshop,
this information can help you avoid unexpected results when
working with these ground-breaking plug-ins.

View Composite Layer

The “View Composite Layer” feature (requires Photoshop 4.0 or
later) allows you to see all of your visible Photoshop layers while
creating your effect, something no other plug-in has allowed you
to do. This is an extremely powerful feature, but current limita-
tions with the Photoshop Application Programming Interface pre-
vent it from working exactly as you might expect. 

How it works: If you choose any layer other than the top-
most layer as the target for your effect, the PhotoEffects
plug-ins (PhotoCastShadow, PhotoBevel, PhotoEmoboss, or
PhotoGlow) display the selected layer as the top layer  in the
Preview window; the effect is applied to this selected layer.

Example: In the composite image shown, the layer named
“text” is the top layer. We have selected the layer named
“medium” (which is below the “text” layer) as the active
layer. We’ll use the image on that layer to create our effect. 

When the PhotoEffect plug-in Preview window is opened
(we’ve selected PhotoCastShadow), you would expect to see
the image in the Preview window exactly as it appears in
Photoshop—with all layers in the correct relationship.That is,
with the “text” layer above and the “medium” layer below.
However, this is not what happens: the selected layer, “medi-
um,” Previews on top.

In order for the PhotoEffects plug-ins to display any compos-
ite preview correctly in all cases, your selection layer must
be the top layer. But even if your selection is not the top
layer, be assured that PhotoTools is not actually rearranging
the layers in your image, only the Preview. If you select the
top layer before opening an effect, the preview behaves nor-
mally.

Photoshop composite image:
Top layer displays on top

Layers palette:“text”is the top layer,
“medium”is the selected layer

PhotoEffects Preview composite image:
Selected layer displays on top
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Create Shadow Only / Create Glow Only

Create Shadow Only (and Create Glow Only) is a feature in the
shadow-effect plug-ins, PhotoCastShadow and PhotoGlow. This
feature allows you to create the effect you want and then separate
it from the image, so that the shadow occupies its own layer. You
may even want to delete the original image, keeping only the
shadow image.

You can do this easily with PhotoCastShadow and PhotoGlow by
first duplicating the layer you want to create a shadow-only effect
for before you open the Effect plug-in.

How it works: When you turn on the “Create Shadow
Only” checkbox, the preview brings the shadow forward.
The Preview is designed this way to give you a visual
clue that you are not just adding a drop shadow to the
original information on the targeted layer. Rather, the
preview is showing you that you are actually turning the
targeted layer into a shadow.

Example: If you wanted to make a cast shadow for the
big wrench, you would duplicate its layer, activate the
layer, then  open PhotoCastShadow. Next you would set
all the parameters for your shadow, such as opacity,
color, edge blur, etc. When you have the shadow looking
the way you want it to, you would turn on the “Create
Shadow Only” checkbox and then click Apply.

By default, PhotoTools always keeps the original infor-
mation on the targeted layer and then adds the shadow
outside (or around, in the case of a glow effect) the orig-
inal image. By duplicating the layer first, you no longer
need to keep the original image pixels intact. Just select
Create Shadow Only, and the image on the targeted layer
will be transformed into a shadow, on its own layer, sep-
arate from the original layer that you duplicated before-
hand!

After choosing Apply, the effect lands on its own layer
where you can change the opacity, position, and blend
mode without altering the original image you had before
creating the effect.

Image and Shadow

Shadow Only
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Actions Palette Awareness/Actions Palette Scripting

Four of the PhotoEffects plug-ins, PhotoCastShadow, PhotoBevel,
PhotoEmboss, and PhotoGlow are Actions Palette aware and
Actions Palette scriptable. PhotoButton is Actions Palette aware
but not scriptable.

For detailed info rm ation on Actions Palette awa reness and A c t i o n s
Palette scripting, refer to your Adobe Photoshop 4.0 User Guide.

Multiple Undos and RAM

All of the PhotoEffects plug-ins allow you to Undo effects
applied in the Preview window multiple times, then Redo as many
of those steps as you like. This feature allows you to experiment
with effect actions, reverting back to earlier actions, then moving
forward to latter actions to compare different effects, or to change
your mind without “losing” any work in the process. 

As you might expect, Undo and Redo work only inside the effect
plug-in, and effect actions are only captured for one session at a
time.

The amount of RAM memory available to Photoshop will impact
how many times you can Undo and Redo effect actions.
Naturally, the more RAM the better, but even with Photoshop’s
recommended RAM settings you’ll have access to dozens of lev-
els of Undo.

Note: For best performance, Photoshop recommends that you do
not use virtual memory software when running Photoshop, but
rather allow Photoshop to manage memory. Refer to the Adobe
Photoshop User Guide for more information.

Color Modes

As with Photoshop itself, not all color modes are available in all
PhotoEffects plug-ins. 

•  RGB
•  CMYK
•  Multi-channel
•  Grayscale
•  Duotone

•  Bitmap
•  Indexed

•  Lab mode 

All PhotoEffects plug-ins
work in these modes

All plug-ins except PhotoText (Mac)
and PhotoButton work in this mode

No Photoshop plug-ins
work in these modes
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Unexpected Results

1. Nothing changes in my image Preview when I make
changes using the effect tools.

E a ch PhotoEffects plug-in allows you to disable re a l - t i m e
v i ew i n g. If you don’t see any ch a n ges in your image as yo u
ap p ly diffe rent effect para m e t e rs , ch e ck the “ O p t i o n s ” m e nu
in the menubar to be sure that “Real Time Prev i ew ” i s
s e l e c t e d.

2. The background (or other layer) doesn’t appear in the
Effect’s Preview window.

If you expected to see all the layers in your picture and didn’t
(and you’re using Photoshop 4.0 or later), check the “View”
menu in the menubar to be sure “View Composite Layer” has
been selected. Also verify that the layers you wish to view
have been selected for viewing in the Photoshop layers
palette.

See also “Additional Information” on page 48. 

3. When I apply my changes I get a warning that if I contin-
ue, my selection will be lost (Photoshop 3.0.x only)

If you’re applying an effect that creates pixels outside of your
original selection area, you will be presented with a dialog
box warning you that your selection will be permanently lost
upon applying the effect. (This applies to PhotoCastShadow,
PhotoBevel outer bevels and PhotoEmboss raise, edge and
blur.) 

To retain your selection:

• Click Cancel in the warning dialog box to return to the
Effect dialog box, then save your settings. (See above.) 

• Click Cancel in the Effect dialog box.
• Choose Save Selection from the Select menu.
• Open the PhotoEffects dialog box and apply the effect.
• After you have run the PhotoEffects filter, you can

restore your selection by choosing Load Selection from
the Select menu.

Note: This problem does not occur in Photoshop 4.x.
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4. I’m working with a Transparent layer (PhotoButton) and
when I click “Reset” there appears to be no button in the
Preview window.

The default fill color for PhotoButton is “Transparent.” When
working on a normal (not Transparent) layer, for example the
background layer, this feature allows the background image to
“show through” a semi-opaque button. This feature allows
you to create stunning button effects with textures, gradients,
etc. Adding this automatic Transparent fill to an already
Transparent layer results in an apparently “invisible” button.
However, the button is there!

To see the transparent button:

Use the Color controls to fill the button so you can see it. or
use the Reshape tool.

— or —

Select the Reshape tool and move it around the Prev i ew win-
d ow—the button frame will appear and show you the bu t t o n .

For more information on Transparent options, refer to the
PhotoButton section of this User Guide.

5. When I select a different blend mode in PhotoCastShadow
or PhotoGlow, nothing seems to happen.

The blend mode in PhotoCastShadow and PhotoGlow only
blends the effect with the pixels in the target layer. If there are
no pixels with color in the target layer, you will see no
“blending” in the Preview.
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P h o t o C a s t S h a d ow is the fa s t e s t , most ro bust shadow ge n e rat o r
ever deve l o p e d. Instantly cre ate pro fessional cast shadows and
drop shadows. Grab a corner, edge, or center of the shadow
frame to interactively rotate, stretch, and skew the shadow to
any perspective, and place it anywhere on the image. Easily
adjust the shadow’s perspective blur to show realistic dimen-
sion—without purchasing and learning a 3-D application. 

Use Inve rt Shadow to cre ate useful cutouts and other effe c t s .
Select Shadow Only to isolate the whole shadow—not just the
s h a d ow outline—on it’s own laye r. See the results of each
e ffect on the composite image intera c t ive ly, as you cre ate it.
And as with all PhotoEffe c t s , you can undo and redo effe c t s
multiple times, and save effects settings for future use.

PhotoCastShadow

K Color Palette Pop-up: Sets the shad-
ow color. Color picked with the eye-
dropper is displayed here.

L Settings Controls: Select, Save, and
Delete effect settings. 

M Help Box: Displays a description of
each tool or option as the mouse
passes over it.

N Adjustment tool: Allows you to shrink,
stretch, rotate, position, and skew the
shadow.

A Preview Window

B X and Y Offsets: How far the shadow
is offset from the image, in pixels. 

C Direction: Slant angle from image, in
degrees. 

Length: How tall the shadow is as a
percentage of image size.

D Rotation Angle: Shadow rotation, in
degrees.

E Blur: Controls amount of shadow blur,
in pixels. This blur is a constant, pro-
viding the same blur value every-
where around the image.

F Perspective Blur: Controls shadow
blur, in pixels. Blur changes depend-
ing on how far the shadow is from its
corresponding spot on the image.
Creates a more realistic 3-D shadow.

G Opacity: Controls translucency of the
shadow, as a percentage. 0% opacity
is completely transparent; 100%
opacity is completely opaque.

H Blend Mode: Normal, Multiply,
Screen, Darken, Lighten, Difference.
Effect is applied only on the target
layer (see page 57 for more details) .

I Invert Selection: Inverts the eff e c t ,
applying the shadow inside the selec-
tion rather than outside it.

J Create Shadow Only: Moves the sha-
dow in front of the selection in the
Preview window. Keeps the shadow
and deletes the image on selecting
Apply (see page 57 for more details).

C

A

E
D

F

K

L

G

H

J
I

B

N

O

M P Q

O Eyedropper: Extracts shadow color
from the preview.

P Cancel: Closes the dialog box without
making changes to the image. Also
Cancel by pressing Command+“.”
(Macintosh) or ALT+F4 (Windows).

Q Apply: Adds your selected effects to
the image and closes the dialog box.
You can also Apply the effect by
pressing Return or Enter.

Note: Many controls, options, and
commands are common to all the
PhotoEffects plug-ins. For detailed
information on those elements,
refer to “The PhotoEffects Plug-
ins” starting on page 35. 

The PhotoCastShadow Dialog box

Tip

For a full listing of keyboard short-
cuts, refer to Appendix A.



Getting Started with PhotoCastShadow

The Shadow Frame
As with all of the PhotoEffects plug-ins, when you open
PhotoCastShadow, the shadow applied to the selected image will
be what was automatically saved in the Setting “Last Used.” But
unlike the other plug-ins, PhotoCastShadow provides you with an
interactive wireframe that bounds the shadow on all sides, so that
you can quickly and easily manipulate the size, shape, and place-
ment of the shadow.

The shadow frame has 8 handles, or hot spots, one on each side
and one on each corn e r, t h at allow you to shri n k , s t re t ch , p u l l , a n d
s kew the shadow into va rious shapes. Two other hot spots, o n e
inside the box and the other outside the box , a l l ow you to position
the shadow—either offsetting it from the image slightly, or placing
it any wh e re on the canvas—and to ro t ate the shadow a full 360°.

You will see the shadow frame whenever you have the
Adjustment tool selected and positioned inside the Preview win-
dow. As you pass the Adjustment tool over the 10 hot spots, the
tool will change shape to indicate the type of movement that will
be applied when you click and drag from that spot. 

The side handles (top, bottom, left, right) can drag the image
from their respective side of the shadow in any direction. The cor-
ner handles can drag the image from their respective corner in
any direction. The inside and outside pointers will drag the entire
shadow and frame.

Shadow Position and Shape Values
The two shadow position controls and most of the shadow shap-
ing controls can be entered in absolute values using the parameter
entry boxes. These include: X and Y Offset, Direction, Length,
and Rotation.

Using these absolute values, a shadow exactly the same size,
shape, and location as the image would have X and Y Offsets of
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zero pixels, a Length of 100%, a Direction of 0%, and a Rotation
of 0°, and would be completely hidden by the image (unless a
Blur has been added, in which case the shadow would “peek”
around the edge of the selection like a glow.)

The one shaping control that does not have an equivalent absolute
value is Corner distortion. To distort from a corner you must use
the Pointer tool to drag from the corner.

Shadow Image Values
Other shadow effects, such as Blur, Perspective Blur, and Opacity,
can be adjusted with the interactive sliders or entered as absolute
values.

Position Controls
The two position controls in PhotoCastShadow, Move and Rotate,
control the position of the shadow in the X/Y plane of the canvas,
and its rotation. The Position Controls, unlike the Shape Controls,
operate on the full shadow, allowing you to move it anywhere on
the canvas, or rotate around its centerpoint a full 360 degrees.

To Position the Shadow:

1. Select the Adjustment tool.

2. Place the tool inside the shadow frame: the pointer
should look like the Adjustment tool.

3. Click and drag the shadow to the desired position, then
release.

— or —

1. Enter the desired position using the X and Y coordinate
boxes.

To Rotate the Shadow:

1. Select the Adjustment tool.

2. Place the tool outside of the shadow frame: the pointer
should look like a circular arrow.

3. Click and drag the shadow to the desired position, then
release.

— or —

1. Enter the desired rotation using the Rotation Angle
attribute box.

Tip

To constrain Adjustment tool to
Side movement during a resize
operation, press Command
(Macintosh) or Control (Windows)
while dragging. 

To constrain the Adjustment tool
to Center movement, press
Option (Macintosh) or ALT
(Windows) while dragging. 



Shape Controls
The 8 handles, or hot spots, along the border of the shadow frame
constitute the Shape Controls. The Shape Controls operate togeth-
er, giving you full freedom to reshape the shadow in nearly any
way imaginable. Parameters affected are the X Offset, Y Offset,
Direction, and Length.

To Distort the Shadow Shape:

1. Select the Adjustment tool.

2. Place the tool on any handle around the perimeter of
the shadow frame: the pointer should look like an
arrow with a directional pointer.

3. Click and drag the shadow to the desired position.

— or —

1. Enter the desired shape parameters in the shape para-
meter boxes.

Note: The only size parameter you cannot change by enter-
ing a value in a parameter box is Corner distortion. To dis-
tort from a corner, you must use the Adjustment tool to
drag from a corner.
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Blurs, Blends, and Color Controls
The Blur, Opacity, Blend, and Color Controls behave exactly as
they would if applied directly in Photoshop, except that the
PhotoCastShadow blend modes only blend the effect pixel with
the target layer pixels (not affecting any underlying layers).

With Pe rs p e c t ive Blur, you have the additional adva n t age of hav-
ing a blur that decreases the closer it is to its corresponding spot
on the image. This makes the shadow look more re a l i s t i c, a l l ow i n g
you to cre ate tru ly pro fessional 3-D effects—in a fraction of the
t i m e, and without the overhead of complex 3-D graphics softwa re.

The Color pop-up allows you to interactively see how your shad-
ow will look as you move the pointer back and forth over the col-
ors in the palette, and the Eyedropper allows you to interactively
see the effect of changing your shadow color using a color from
the Preview window.

Invert Selection
Allows you to invert the shadow color and move the shadow from
outside the image to inside it, creating a variety of interesting
effects, including cutouts.

Create Shadow Only
Allows you to separate the shadow from its image permanently,
and provides you with a full shadow image, not just the outline.
When you select this option the shadow will move in front of the
image in the Preview window, and the image itself will be dis-
carded when the effects are applied.

Important: If you wish to keep a copy of the original image layer
after selecting and applying Create Shadow Only, you must cre-
ate a copy of the layer before opening PhotoCastShadow.

Tip

To “start over” when your image
has been skewed beyond useful-
ness, click Reset. 

To maintain Color and Blur set-
tings while Resetting all other
effect parameters, press Option
(Macintosh) or ALT (Windows)
when you click Reset.
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Shadow Preset Settings
PhotoCastShadow includes several default shadows, plus a num-
ber of preconfigured effect Settings which you may want to use
“as is,” or as a starting point for more creative and complex shad-
ow effects. 

Default shadow settings include: Last Used, Drop Shadow, Cast
Shadow, and Cutout. Last Used is updated each time your effects
are applied to the image, and will be automatically reapplied each
time you open PhotoCastShadow. To change this setting, either
click Reset to eliminate all shadow effects (start from scratch),
select a new effect setting from the pop-up menu, enter values in
the attribute boxes, or just begin manipulating the shadow frame.

For more detailed information on creating, selecting, saving, and
using Settings, refer to pages 38 and 39.
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Bevels give the selected part of an image a raised appearance by
applying highlights and shadows to the inside and outside edges.

With PhotoBevel, you have point and click control over four dif-
ferent bevel types: Flat, Round, Slope, and Double. You can apply
your bevel to the inside or outside edge of the selection area, con-
trol bevel edge tolerance, and more.

All bevel options, including edge feathering, softness, highlights,
shadow intensity, and light direction respond in real-time, and you
can optionally view composite layers to see just how your effects
will look with other picture elements.

J Help Box: Displays a description of
each tool or option as the mouse
passes over it.

K Highlight Eyedropper: Extracts a
highlight color from the preview.

L Shadow Eyedropper: Extracts a
shadow color from the preview.

M Cancel: Closes the dialog box without
making changes to the image. You
can also Cancel by pressing
Command+“.” (Macintosh) or ALT+F4
(Windows).

N Apply: Adds your selected effects to
the image and closes the dialog box.
You can also Apply the effect by
pressing Return or Enter.

A Preview Window

B Bevel Type: Controls Inner and Outer
Bevel options. Outer is only active if
you’ve selected less than the entire
image. 

Bevel Shape: Controls bevel shape
(Flat, Round, Slope, or Double).

C Edge Tolerance: Refers to feathered
and implicit selections. Allows you to
control which pixels PhotoBevel con-
siders the edge. Maximum: All feath-
ered pixels are used when defining the
bevel area; Minimum: No feathered
pixels used; Medium: Half of feathered
pixels used.

D Width: Determines bevel width.
Softness: Similar to a blur; it softens
the transition points between light and
dark.

E Balance: Adjusts balance between the
Highlight and the Shadow of the bevel.

F Highlight and Shadow Intensity:
Control the strength of bevel highlights
and shadows.

G Light Direction Field and Indicator:
Adjusts the direction of the light
source and indicates direction in °.

H Highlight and Shadows Pop-up Color
Palettes: Sets the bevel highlight and
shadow colors. Colors picked with the
eyedroppers are displayed here.

I Settings controls: Save, Select, and
Delete effect Settings.
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Note: Many controls, options, and
commands are common to all the
PhotoEffects plug-ins. For detailed
information on those elements,
refer to “The PhotoEffects Plug-
ins” starting on page 35.  

The PhotoBevel Dialog Box

Tip

For a full listing of keyboard short-
cuts, refer to Appendix A.
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PhotoEmboss works like no other embossing tool. Its unique con-
trols and emboss styles give you the ability to create cutouts,
embosses, reliefs, recesses, and many other special effects.

PhotoEmboss includes options for selecting the emboss type,
along with the amount, of embossing. You control the contrast,
softness, highlight and shadow of the embossing. In addition, you
can position a directional light source and customize the color of
the emboss highlight and shadow.

PhotoEmboss

J Help Box: Displays a description of
each tool or option as the mouse
passes over it.

K Highlight Eyedropper: Extracts a
highlight color from the preview.

L Shadow Eyedropper: Extracts a
shadow color from the preview.

M Cancel: Closes the dialog box without
making changes to the image. You
can also Cancel by pressing
Command+“.” (Macintosh) or ALT+F4
(Windows).

N Apply: Adds your selected effects to
the image and closes the dialog box.
You can also Apply the effect by
pressing Return or Enter.

A Preview Window

B Emboss Type: Cutout, Raise, Edges,
Blur.

Cutout typically pushes in the selection
area; Raise typically pushes out the
selection area.

Edges applies the highlight and shad-
ow emboss colors around the inside
and outside of the selection edge. This
effect more dramatically defines the
selection edge.

B l u r creates an off focus, fuzzy emboss.

C Amount: Indicates Width of the emboss.

D Softness: Similar to a blur—softens the
transition points between light and dark.

Contrast: Controls the amount of dif-
ference between lightness and dark-
ness of the emboss.

E Highlight and Shadow Intensity:
Controls the strength of emboss high-
lights and shadow edges.

F Invert: Changes emboss effect 180°.

G Light Direction Field and Indicator:
Adjusts the direction of the light source
and Indicates direction in degrees.

H Highlight and Shadow Pop-up Color
Palettes: Determine the bevel highlight
and shadow colors. Colors picked with
the eyedroppers are displayed here.

I Settings controls: Save, Select, and
Delete effect Settings.
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Note: Many controls, options, and
commands are common to all the
PhotoEffects plug-ins. For detailed
information on those elements,
refer to “The PhotoEffects Plug-
ins” starting on page 35.  

The PhotoEmboss Dialog box

Tip

For a full listing of keyboard short-
cuts, refer to Appendix A.
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As an artist, imagine creating an image of a neon sign or a can-
dle. You would typically add a glow effect around the outer edges
of the neon sign and around the candle’s flame. PhotoGlow
makes this process easy: apply a high radiance for a soft, subtle
glow or a low radiance for an intense, hard, bright glow.

Ap p ly a solid glow to the selected image or just to its edge s .
D e t e rmine how far the glow should ex t e n d, and control its ra d i a n c e
( g l ow diffusion). In addition, you can add a solid stroke around
any selection. 

Change glow opacity (how much the glow will show through) to
highlight an image containing light text on a light back gro u n d :
choose a glow color darker than the back gro u n d, then increase the
opacity of the letters ’ g l ow to make them more visible against the
light background.

J Settings controls: Save, Select, and
Delete effect Settings.

K Help Box: Displays a description of
each tool or option as the mouse
passes over it.

L Eyedropper: Extracts a glow color
from the preview.

M Cancel: Closes the dialog box without
making changes to the image. You
can also Cancel by pressing
Command+“.” (Macintosh) or ALT+F4
(Windows).

N Apply: Adds your selected effects to
the image and closes the dialog box.
You can also Apply the effect by
pressing Return or Enter.

A Preview Window

B Glow Type: Edge, Solid

Edge applies the glow effect to the
area defined by the selection edges.

Solid ignores enclosed selection areas
within the selection. Fills in the hollow
areas like the center of a selected “O.”

C Stroke Shape: Square, Round

D Stroke Width: Controls the number of
pixels from the image that the glow
extends. A higher number indicates a
fatter glow.

E Radiance: Indicates how abruptly the
outer edge of the glow diffuses. A high
number indicates higher diffusion.

F Opacity: Indicates the percentage of
the glow that is allowed to be seen in
the image.

G Blend Mode: Normal, Multiply, Screen,
Darken, Lighten, Difference. These
produce the same effect as when
applied directly in Photoshop, except
the effect is applied only on the target
layer (see page 57 for more details).

H Create Glow Only: Moves the glow in
front of the selection in the Preview
window. Keeps the glow and deletes
the image on selecting Apply (see
pages 49 and 57 for more details).

I Color Palette Pop-up: Sets the glow
color. Color picked with the eyedrop-
per is displayed here.
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Note: Many controls, options, and
commands are common to all the
PhotoEffects plug-ins. For detailed
information on those elements,
refer to “The PhotoEffects Plug-
ins” starting on page 35.  

PhotoGlow

The PhotoGlow Dialog box

Tip

For a full listing of keyboard short-
cuts, refer to Appendix A.
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With PhotoButton, quickly construct beautifully-rendered, uni-
form buttons from 16 predefined, completely customizable
shapes. Saves tremendous time over “hand-rolling” individual
buttons—the perfect tool for Web and Multimedia projects.

Select an “Anchor Button” against which all button shapes will be
created. Specify how many buttons in the matrix, across, down, or
both, then use the interactive shape controls to rotate , create and
alter bevel height, bevel width and curvature, change corner
radius, set the button inner height, and more. Color controls
include surface reflectivity, diffuse angle, highlight color, high-
light ratio, and highlight directional control. Fill all buttons with
the same color or with different colors.

PhotoButton

G Settings Controls: Select, Save, and
Delete effect settings. 

H Help Box: Displays a description of
each tool or option as the mouse
passes over it.

I Resize tool: Adjust Anchor Button
size and position (affects all buttons).

J Reshape tool: Adjust Anchor Button
shape (affects all buttons).

A Preview Window

B Color Tab: Contains color options for
the inner, outer, and bevel areas of
the buttons.

C Shape Tab: Contains shaping options.
The Shape tab options are described
on page 60.

D Paint Color: Determines the color to
be applied to the button parts. Use
the Paint Bucket to apply this color to
the selected part of any button individ-
ually. Use modifier keys to apply this
color to the selected part of all buttons
simultaneously. (See page 67.)

Paint Bucket:  Use the paint bucket to
color each button’s inner, outer, and
bevel areas individually.

Eyedropper: Extracts the Paint Color
from the Preview.

E I n n e r, Bevel, and Outer Ta b s : P r o v i d e s
access to separate Surface Property
controls for the Inner and Bevel parts
of the button, and the button Outer
area (button background). These tabs
are described in detail on page 59.

F Highlighting: Controls the light source.
Parameters that can be affected are
Color, Direction, and Inclination. Use
the control knob on the directional
model to change Direction and
Inclination simultaneously.

Color: Selects the color of the light
being cast over the button parts.

Direction: Controls the direction of the
light source. 

Inclination: Controls the arc of the light
over the three dimensional surface.
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K Cancel: Closes the dialog box without
making changes to the image. You
can also Cancel by pressing
Command+“.” (Macintosh) or ALT+F4
(Windows).

L Apply: Adds your selected effects to
the image and closes the dialog box.
You can also Apply the effect by
pressing Return or Enter.

BC

The PhotoButton Dialog box

Note: Many controls, options, and
commands are common to all the
PhotoEffects plug-ins. For detailed
information on those elements,
refer to “The PhotoEffects Plug-
ins” starting on page 35.  

Tip

For a full listing of keyboard short-
cuts, refer to Appendix A.
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The Surface Property tabs, consisting of
the Inner and Bevel button parts, and
button Outer area, provide access to
color surface property settings for the
three parts individually. Values shown in
the tab affect the selected part of all
buttons in the matrix.

A Inner Tab: Specify color parameters
for the inner area of the button.

B Bevel Tab: Specify color parameters
for the bevel area of the buttons.

C Outer Tab: Specify color parameters
for the area outside of the buttons.

D Surface Reflectivity: Controls the
amount of light reflected or absorbed.
0% yields a matte (all light is absorb-
ed, no reflection); 99% yields a high
gloss (very reflective). See Note
under Highlight Ratio.

E Diffuse Angle: Controls the degree to
which light is diffused on the surface.
1% yields a focused, spotlight effect;
90% yields a diffused wash of light. 

F Highlight Ratio: Controls the amount
of light striking the button part (similar
to using a dimmer switch). N o t e : I f
the Highlight Ratio is set to ze r o
(indicating no light) there can be no
s u r face reflectivity.

G Preset: Sample settings showing com-
mon effects achieved by changing the
various Surface Property parameters.

H Transparent: Applies to Outer button
part only. When on, makes all the pixels
outside the button transparent. (See
Note on page 70.)

I No Highlighting: When on, no light
strikes the selected button part.
Disables the color controls. (Same
effect as setting all three color controls
to their minimum values.)
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The Surface Property Tabs
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The Shape Tab provides access to all
shaping options for the buttons. 

A Color Tab: Contains color options for
the inner, outer, and bevel areas of
the buttons. Color tab options are
described on pages 62 and 63.

B Shape Tab: Contains shaping options. 

C Number: Specify number of buttons in
rows (horizontal) and number of but-
tons in columns (vertical). 

D Width and Height: Specify A n c h o r
Button size (affects all buttons).

Lock/Unlock: When lock is on, con-
strains button size to values entered
in the Width and Height parameter
b o x e s .

E Shape: Choose from 16 common,
multi-purpose shapes.

F Rotation Angle: Rotates all the but-
tons. Rotation is not applicable to all
shapes (for example, Circles). Note:
When Rotation Angle is adjusted, all
manual resizing, repositioning, and
reshaping (using the Reshape tool) is
undone.

G Corner Radius: Controls curve of but-
ton corners. N o t e : When Corn e r
Radius is adjusted, all manual resiz-
ing, repositioning, and reshaping
(using the Reshape tool) is undone.

H Inner Height: Makes the inner part of
the button convex or concave. 100%
is maximum convex, 0% is flat.

I Bevel Height: Adjusts bevel lighting to
make the button look shorter, taller,
more convex or more concave.

J Bevel Width: Controls bevel width.

K Bevel Curve: Adjusts lighting to give the
bevel curve concave or convex eff e c t s.
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Getting Started with PhotoButton

PhotoButton allows you to automatically create a matrix of same-
shape buttons using a single “Anchor Button” as the copy source.
As you work with the Anchor Button, selecting and adjusting the
shape, contour, and bevels to achieve just the right effect, you will
see the effect on all the buttons automatically. Use the color con-
trols to set reflectivity, diffusion, and highlighting, coloring all
buttons the same, or optionally coloring each button individually.

This section will help you understand how the different parame-
ters interact. For detailed instructions on how to create buttons,
refer to “Creating Your Own Buttons” starting on page 73.

Image Area
When you open PhotoButton, a maximum Image Area is set. The
Image Area is the maximum area, Width + Height, that your but-
ton matrix can occupy. You specify the image area either explicit-
ly by selecting an image area before opening PhotoButton, or
i m p l i c i t ly by opening PhotoButton on any laye r, i m age, or window. 

The image area selected when PhotoButton is opened will be the
maximum area you can work with for that PhotoButton session.
As you determine how many buttons will be in your matrix, and
how big each button will be, the total Image Area will automati-
cally be partitioned into equal parts to accommodate your choic-
es. 

Your button size will be constrained by how many buttons you
want in the matrix. Conversely, how many buttons you choose for
the matrix will constrain how much space each individual button
will occupy. For example: If you select a 100 pixel by 100 pixel
area, and you wish to have 2 rows and 2 columns of buttons, each
button can be no larger than 50 pixels x 50 pixels.

Setting the Initial Parameters: Number, Size, and Shape
When you initially open PhotoButton, you must indicate how
many buttons you wish to work with and how those the buttons
will be arranged (rows and columns). This sets the parameters for
the Button Matrix. (Note: A matrix can be composed of a single
button, indicated as 1 across and 1 down).

You may also choose to set the Width and Height of each button.
Since all buttons in the matirx will have identical shapes, the
Width and Height specification applies to all the buttons.

Button Matrix

Image Area: Width + Height

Sample Buttons Created
in PhotoButton



Once the matrix parameters have
been set, changing the number of
buttons will affect both the size
and spacing of the buttons, unless

your settings are size protected. If you do not want your button
size to change (until you indicate a change by entering new values
in the Width and Height boxes, or by manually resizing with the
Resize tool), you can the lock the Width and Height by clicking
on the lock icon.

You can select a shape for the button from the Shape pop-up
menu on the Shape tab at any time. As soon as you select a shape
you can immediately see how the parameters you’ve set will
affect it. Remember that your results will be impacted by whether
or not you lock the button size.

The Anchor Button
Once you have established the parameters of the matrix (button
number, arrangement, size, and basic shape), you will work with
one button and PhotoButton will automatically apply your
changes to all the other buttons. This primary button is called the
Anchor Button, because all the other buttons are “anchored” to
this button. If you reposition or resize the Anchor Button, all the
buttons are repositioned and resized.

The Anchor Button is always the first button in the matrix, located
in the upper-left corner of the button matrix. When you select
either the Resize tool or the Reshape tool, the bounding box and
handles that allow you to work with the button will always be
shown on the Anchor Button. These Resize and Reshape tools are
described in “Positioning, Sizing and Shaping” on page 69.
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Button Size
Since the Image Area is divided equally among the buttons in the
matrix, it is more accurate to think of button “size” as the total
area, Width + Height, that the button will occupy. This would
include a share of the space between a button and its surrounding
neighbors. So the space between buttons is not “empty” space—it
is an integral part of the button. 

Note: You can create the illusion of empty space between buttons
by coloring the outer part Transparent or None (no color). Refer
to page 70 for more information on the Transparent and None
options.

Button Parts
Each button is composed of two parts: the Inner area and the
Bevel area. The Outer area is all the space outside the buttons.
Surface parameters, such as color, reflectivity, diffuse angle and
highlight ratio, can be defined separately for each of the button
areas. 

Inner area: The Inner area of the button is the space inside the
button extending up to the Bevel area. Changes in Bevel Width or
Corner Radius will affect the size of the Inner area.

Bevel area: The Bevel area of the button completely surrounds
the Inner area. It provides the boundaries of what you might com-
monly think of as the button itself, not taking into account the
space around the buttons.

Outer area: The Outer area consists entirely of the space
between and around each button, including any space between the
button and the outermost edges of the Image area. The Outer area
will change as buttons are resized and reshaped. Color is applied
to the entire Outer area at once, not on a button by button basis,
as the with the Inner and Bevel areas.



Before: 3x3 Matrix
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Locking the Button Size
If button size must remain constant (for example, your buttons all
must be 50 pixels by 50 pixels), you can “lock” them to that size
using Size Lock/Unlock. Without the lock on, PhotoButton
assumes that you want to fill the available space with buttons, and
sizes the buttons accordingly.

When the Size Lock is on, changing the Number, Shape,
Style, Rotation Angle, or Corner Radius does not affect
button size. The buttons can still be resized manually

using the Resize tool, or by typing in values in the Width and
Height parameter boxes.

When the Size Lock is off, changing the Number, Shape,
Style, Rotation Angle, or Corner Radius will undo all
manual resizing, and the buttons will be resized to entire-

ly fill their section of the image area.

Note: When the lock is on, increasing the number of buttons will
decrease the space between them. If a particular number of but-
tons will not fit on the canvas without resizing the buttons, that
number will be grayed out in the Number pop-up menu. 

Example: We started with a canvas 200 pixels square, then creat-
ed a 3x3 matrix of buttons specifying that each button be 50 pix-
els wide by 50 pixels high. This is shown in the figure on the left.

We then decided to change to a 2x3 matrix. In the figure on the
bottom-left (A), we locked in the button size with the Size Lock,
then selected “2” from the Rows pop-up. In the figure on the bot-
tom-right (B), we did not lock in the button size before selecting
“2” from the Rows pop-up. Notice that when button size is lock-
ed, the Outer area (space) grows to fill the Image Area. When the
button size is not locked, the buttons grow to fill the Image Area.

After:
2x3 Matrix

A B
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Positioning, Sizing, and Shaping
The button matrix can occupy all of, or any part of, the total
Image Area. The matrix can be moved about in the Image Area,
and the buttons can be resized and reshaped. However, individual
buttons cannot extend outside of their part of the button matrix.

Repositioning: All buttons in the matrix move in relationship to
the Anchor Button, regardless of the number, shape, or size of the
buttons.

Resize tool: The Resize tool can be used to reposition
the buttons within the mat ri x , and to intera c t ive ly
ch a n ge the Width and/or Height of the buttons. As the

A n chor Button is repositioned or re s i ze d, all of the other bu t t o n s
will fo l l ow.

Reshape tool: The Reshape tool can be used to stre t ch
and distort the A n chor Button. Drag a corner handle to
ch a n ge the length and angle of the sides. Drag a side

handle to move the entire side without ch a n ging its length or
a n g l e.

Resize/Reposition Tool

Reshape Tool

Reshape
from Side 

Tip

When the Reshape tool is posi-
tioned in the center of the
Anchor Button, it changes to
the Resize tool, allowing you to
move the button matrix without
changing tools.

Note

Adjusting Corner Radius or
Rotation Angle, or choosing a
new shape from the Shape pop-
up, will cause any manual
Reshaping or Resizing (with the
Resize or Reshape tool) to be
undone. For example, if you
stretch the arm of a star using
one of these tools, adjusting the
Corner Radius or Rotation
Angle control will cause the arm
to revert to its normal setting.

Repositioning a
Button Matrix

Reshape from
Corner
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Button Color 

Note: Options that affect color are discussed in “Creating Color
Effects using Surface Property Controls” on page 72.

Color can be applied separately or simultaneously to the two but-
ton parts (Inner and Bevel) and the button Outer area.

Paint Color pop-up: Provides access to the PhotoButton Color
Palette, the current Photoshop Foreground and Back-ground col-
o rs , and the Color Picke r. Color values are shown on the right side
of the palette, re flecting both the current Color Mode (RGB,
C M Y K , etc) and the color values of the highlighted color. 

Note: In RGB mode, the Color pop-up displays all and only
“web-safe” colors. This does not mean that the final result color
will be web-safe, since button colors may be blended and/or faded
to the background.

None: Remove or fill previously used color with No Color.
Similar to resetting the color, but the None color swatch must be
selected and applied as the Paint Color. Areas of the image col-
ored “None” will show their original content.

Transparent: Transparent color. Value will always be 0%
(opaque) except for the transparent color. This option becomes
available when you are working on a layer with transparency. It
can be used to “knock out” the background around the buttons.

Note: Photoshop’s background layer does not include
Transparency. To add Transparency to the background layer, dou-
ble-click it and hit Return or Enter.

Note: When working on a normal (not Transparent) layer, for
example the background layer, this feature allows the background
image to “show through” a semi-opaque button, allowing you to
create stunning button effects with textures, gradients, etc.
Clicking Reset returns the buttons to their default condition, caus-
ing it to look like the buttons have disappeared. For instructions
on how to make the button visible, refer to page 52.
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To Color Button Parts Individually:

1. Select a color from the Paint Color pop-up, or use the
Eyedropper to extract a color from the Preview.

2. Select the Paint Bucket tool, then click the button part
you wish to color.

With the Paint Bucket tool selected you can color any part
of any button by clicking on it.

To Color a Button Part for all Buttons Simultaneously:

1. Click and hold the Paint Color Pop-up.

2. Press and hold the modifier key for the button part you
wish to color.

Modifier keys:

Inner: Shift (Macintosh) (Windows)

Bevel: Option (Macintosh) or ALT (Windows)

Outer: Command (Macintosh)

3. When you see the color you want to apply to the button
part, release the modifier key and/or the pop-up.

— or —

1. Select the Eyedropper tool, then drag it over the
Preview.

2. Follow steps 2 and 3 above.

— or —

1. Select the desired color using either the Paint Color
pop-up or the Eyedropper.

2. Select the Paint Bucket tool.

3. Hold down the Option key (Macintosh) or the Control
key (Windows) and click the Paint Bucket tool on the
button part you wish to color.

The selected color will be applied to the selected button
part of all the buttons.

Tip

Using the modifier keys and the
Paint Color pop-up, you can
select and fill all parts of all but-
tons without ever leaving the color
pop-up. Simply keep the pop-up
open and a modifier key down
and watch the Preview. When you
see the color (or effect) you want,
release the modifier key. Keep the
pop-up open and press the modifi-
er for the remaining button parts.
You can change colors this way
until you achieve just the right
effect.

This tip works with the
Eyedropper tool as well—with a
modifier key pressed, drag the
Eyedropper over the Preview and
watch the button color change.
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Creating Color Effects Using Surface Property Controls
Once you have selected and applied a Paint Color to the selected
button part, you can adjust or apply effects to the color using the
Surface Property Controls in the Inner, Bevel, and Outer Color
tabs. Surface Property Controls include: Surface Reflectivity,
Diffuse Angle, and Highlight Ratio.

Surface Reflectivity: Controls the amount of light reflected or
absorbed. 0% reflectivity yields a matte look, where all light is
absorbed resulting in no reflection. 99% reflectivity yields a high
gloss look, with maximum reflectivity.

Diffuse Angle: Controls the degree to which light is diffused over
the surface. 1% diffusion yields a focused, spotlight effect, while
90% diffusion yields a diffused, washed-out effect.

Highlight Ratio: Controls the amount of light striking the select-
ed button part. 0% highlight yields no light. 100% yields maxi-
mum light.

No Highlighting: Disables the three Color Controls: Surface
Reflectivity, Diffusion, and Highlight Ratio. The effect is as if all
controls were set to minimum.

Highlighting Color and Effects

The Highlighting Color Controls determine what Color will be
used to highlight the button, and the Direction and Inclination of
the light source for highlighting. Highlighting affects all the but-
ton parts unless you choose No Highlighting in the tab for any or
all of the three button parts.

Highlighting Color pop-up: Used to select the color of the light
being cast over the button parts. Similar to the button parts Color
pop-up, but selects highlighting color. Note: None and
Transparency cannot be used for the Highlight Color.

Direction: Controls the direction of the light source on a two-
dimensional plane. Can be likened to shining a light on the image
from north, south, east, or west, or any point in between.

Inclination: Controls the arc of the light source over the three
dimensional plane. Can be likened to shining a light on the image
from above, to the side, or any point in between. 90° Inclination
indicates that the light source is directly over the image.

Interactive Controls: Use the directional model control knob to
change Direction and Inclination simultaneously. When the knob
is in the center, inclination is 90°. 0° inclination means the light
source is in the same plane as the buttons.

Control Knob for
Interactive Control

Highlighting Color Controls
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Creating Your Own Buttons—A Quick Tutorial

The following real-world example will show you how quickly and
easily you can create your own professional quality 3-D buttons.

Choose a Canvas Size:

1. Open a new file in Photoshop.

Select “New” from the file menu, or press Command+N
(Macintosh) or Control+N (Windows).

2. Select a canvas size large enough to contain the number
and size of buttons you wish to create.

By default, PhotoButton will create your buttons so that
their edges are not touching, unless the size and number of
buttons you request would completely fill the canvas. If the
edges of the buttons you create are touching, either
increase the canvas or the selection area, or reduce the
number or size of buttons.

In our example, we set the Photoshop file parameters as
follows:

Width = 288 pixels
Height = 325 pixels
Resolution =72 dpi
Contents = White
Mode = RGB  

3. In Photoshop, open the Layers Palette, then double-
click on the Background layer and change the to
“Buttons.”

Choose a Button Shape:

1. Open PhotoButton by clicking its button on the
PhotoTools Commands palette, or choose PhotoTools >
PhotoButton > PhotoButton from the menubar.

If you or someone else has used PhotoButton before, it will
display the Last Used settings. To start from scratch, click
the Reset button. This will restore the settings to their
default values.

2. C l i ck the Shape pop-up and select a shape for your bu t t o n s .

PhotoButton comes with over a dozen prebuilt yet completely
customizable shapes. You can use a shape “as is” or resize,
re s h ape and add effects to ch a n ge it into wh at ever shape yo u
like. For our example, we chose the “Round Bar” shape.
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Specify Number and Size of Buttons:

The first time you use PhotoButton it will assume that you
want to create just one button, and that this button will fill the
entire canvas or selection area. If you want to make the button
smaller or create more than one button, you will need to modi-
fy either the number or size settings, or both.

1. Select the number of buttons to be created.

From the Number pop-up, select the number of buttons in
your matrix, both horizontally and vertically.

In our example, we set the matrix to 1 across and 4 down.

2. Set the Size Lock by clicking on the Lock icon.

When you want to specify and maintain a particular size
button, you should “lock in” the size by clicking the lock
button. Locking the Size Lock tells PhotoButton that the
button size you will be entering (or changing using the
Resize tool) is the size you want maintain as you manipu-
late other button parameters. If you do not lock the button
size, PhotoButton may resize your buttons as you change
other parameters, in its attempt to best use the available
space.

3. Set button size by entering Width and Height values in
the size parameter boxes.

Using the Width and Height size parameter boxes you can
specify the exact dimensions of your buttons. 

We set button size as follows:

Width = 250 pixels, Height = 55 pixels.

PhotoButton creates the buttons in the size you indicated,
and automatically redistributes the remaining space evenly
around the buttons.

Set the Shape and Bevel Options:

There are several options in PhotoButton that will give your
buttons a beveled look. (Refer to page 64 for a description of
each option.) 

1. Use the sliders or enter numeric values for the button
shape and bevel options.
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We selected the following:

Rotation Angle = 0
Corner Radius = 100
Inner Height = 100
Bevel Height = 50
Bevel Width = 20
Bevel Curve = 50

Determine Color and Highlighting:

1. Click the Color tab to access the Surface Properties
tabs.

There are three areas of a button that can be colored and
highlighted: the Inner and Bevel parts of the button, and
the button Outer area, or background (see “Getting Started
with PhotoButton” for a description of Surface Properties.)

2. Choose a color from the Paint Color pop-up and apply
it using the Paint Bucket.

There are a number of quick and easy ways to choose and
apply colors to button parts. These are described in the sec-
tion “Button Color”on page 71.

Generally, if you want to paint each button a different
color, use the Paint Color pop-up to select a color, then
select the Paint Bucket and click the area of the button you
would like to change.
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Knowing exactly where to click with the Paint Bucket can
be a little tricky—but if you watch the Help Box in the bot-
tom-left corner of the PhotoButton window, you see that
the selected button part is displayed as you move the Paint
Bucket over the canvas. When the name of the part you
wish to color appears in the Help Box, click the mouse to
apply the paint color.

4. Choose a color from the Paint Color pop-up and apply
it to all buttons simultaneously.

If you want to paint all of the buttons the same color, there
is a much more interactive way to apply the color: Hold
down the Shift or Option key (Macintosh) or Shift or ALT
key (Windows) as you drag the mouse over the colors in
the Paint Color pop-up. You will see the button color
change as you move the mouse over the palette colors.
Shift applies color to the Inner button area, Option
(Macintosh) or ALT (Windows) applies color to the Bevel.
(See page 70 for details on color selection).

5. Enter the Color Adjustment Parameters and Presets.

From the Inner and Bevel tabs we selected the following:

Surface Reflectivity = 30
Diffuse Angle = 30
Highlight Ratio = 30
Preset = Rubber

From the Outer tab we selected:

Transparent 
No Highlighting
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Highlighting settings for all tabs:

Color = White 
Direction = –45° 
Inclination = 45°

6. Click “Apply.”

You have just created your own realistic 3-D buttons!

Adding Text and Glows to Your Buttons

Now that you know how to easily create striking 3-D buttons, you
may want add some other effects, such as text and glows. You will
see how much easier it is to add text using PhotoText than using
Photoshop’s traditional text tools. 

Let’s create some labels for our buttons. With PhotoText you can
create all four labels at once! And because you can actually see,
through the Preview window, the effect of the text on your but-
tons, you can position the text right where you want it as you cre-
ate it.

Adding Text to Buttons with PhotoText:

1. Without making any changes to the button file you cre-
ated in the first Tutorial, open PhotoText.

You will see your buttons in the Preview window.

Phototext will create your text on a new layer so that you
can move it, change it, or delete it at any time—without
affecting your image.

2. Select the Text tool, click and drag a text box, then
enter the text for the first button.

We selected a SanSerif font and colored it white.

3. Position the text where you want it over the button.

4. When you have the text just how you want it, copy and
paste it to create the text for the other buttons.

5. When you have the text for all the buttons complete,
click “Apply.”
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Using Glows to Create a Second Button State:

After you have created buttons with text, it is easy to create a
second version of your buttons to represent a different button
state. For example, you might be creating a rollover effect on
a Web page, where the button changes as the user passes the
mouse over it. One way to differentiate the states is to add a
glow effect to one state. This is a snap with Photo Glow!

1. Duplicate the text layer created in PhotoText and verify
that this new layer is the active layer.

To make the buttons appear to be turned “On” you’ll want
to duplicate the text layer and add the glow effect to the
new layer.

2. Open PhotoGlow by clicking its button on the
PhotoTools Commands toolbar, or selecting PhotoTools
> PhotoGlow > PhotoGlow from the menubar.

To make the buttons appear to be “turned on” you’ll want
to duplicate the text layer and add the glow effect to the
new layer.

3. Use the interactive controls to create the glow effect you
want.

We create our glow using the following settings:

Glow Type = Edge
Stroke Shape = Round
Stroke Width = 2
Radiance = 2
Opacity = 70
Blend Mode = Normal
Color = White

4. Click “Apply.”

Note: For an even more subtle “Off” button effect, in the
Photoshop Layers Palette, change the Layer Blend Mode of
your original text layer to “Soft Light.”

Button “Off”

Button “On”
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Cut Command+X Control+X
Copy Command+C Control+C
Paste Command+V Control+V
Select All Command+A Control+A
Undo Command+Z Control+Z
Redo Command+Z Control+Y
New Text Block Command+N Control+N
Duplicate Block  (Arrow tool selected) Command+D —
Save Text Blocks Command+S Control+S
Open Saved Text Blocks Command+O Control+O
Apply Effect  (and close dialog box) Enter or Command+P Control+I
Apply Directly to image Option+Click Apply ALT+Click Apply
Cancel  (and close dialog box) Command+. or Command+W ALT+F4 or Control+W
Font Size

Increase in 1 point increments Command+SHIFT+> —
Decrease in 1 point increments Command+SHIFT+< —

Kern/Track
Increase 1/20 EM Command+SHIFT+} —
Decrease 1/20 EM Command+SHIFT+{ —
Increase 1/200 EM Command+SHIFT+Option+} —
Decrease 1/200 EM Command+SHIFT+Option+{ —

Character Scaling
Increase 5% Command+] —
Decrease 5% Command+[ —

Leading
Increase 1 point Command+SHIFT+” —
Decrease 1 point Command+SHIFT+: —

Character Styles
Bold Command+B Control+SHIFT+B
Italic Command+I Control+SHIFT+I
Underline Command+U Control+SHIFT+U

Alignment
Left Command+L Control+L
Right Command+R Control+R
Center Command+M Control+M
Justify Command+J Control+J

Nudge  (Arrow tool selected)
Left 1 point ß ß
Right 1 point à à
Up 1 point á á
Down 1 point â â

Toggle Text tool and Arrow tool Command+Tab Control+Tab
Zoom In Command+“+” Control+Keypad “+”
Zoom Out Command+“–” Control+Keypad “–”

Option+Zoom tool ALT+Zoom tool

Appendix A: Keyboard Shortcuts

Function Performed Macintosh Windows

PhotoText
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Cut Command+X Control+X
Copy Command+C Control+C
Paste Command+V Control+V
Select All Command+A Control+A
Undo Command+Z Control+Z
Redo Command+Y Control+Y
Apply Effect  (and close dialog box) Return or Enter Return or Enter
Cancel  (and close dialog box) Command+. or Escape ALT+F4 or Esc
Pan and Zoom

Zoom In Command+“+” Control+Keypad “+”
Zoom Out Command+“–” Control+Keypad “–”

Option+Zoom tool ALT+Zoom tool
Access Hand tool from any tool Spacebar —
Access Magnifier “+”  from Hand tool Command —
Access Magnifier “-”  from Hand tool Option —
Access Magnifier “+”  from other tool Spacebar+Command —
Access Magnifier “-”  from other tool Spacebar+Option —

Fit on Preview Command+0 Control+0
Actual Pixels Command+Option+0 Control+ALT+0
View Composite Layer Command+L Control+L
Parameter Boxes

Move forward one character à à
Move backward one character ß ß
Move forward one box Tab Tab
Move backward one box SHIFT+Tab SHIFT+Tab

PhotoCastShadow only
Toggle Show/Hide Outline Command+H —
Reset Shape Options Only Option+Reset ALT+Reset
Constrain to Side movement Adjust tool+Command+Drag Adjust tool+Control+Drag
Constrain Horizontally/Vertically Adjust tool+SHIFT+Drag Adjust tool+SHIFT+Drag
Resize from Center Adjust tool+Option+Drag Adjust tool+ALT+Drag
Resize from Corner Adjust tool+Command+Drag Adjust tool+Control+Drag

PhotoButton only (*affects all buttons)
Fill Inner* Command+I Control+I
Fill Inner* with Pop-up Color SHIFT+Select color SHIFT+Select color
Fill Inner* with Extracted Color SHIFT+Eyedropper+click SHIFT+Eyedropper+Click
Fill Bevel* Command+B Control+B
Fill Bevel* with Pop-up Color Option+Select color ALT+Select color
Fill Bevel* with Extracted Color Option+Eyedropper+click ALT+Eyedropper+Click
Fill Outer* Command+U Control+U
Fill Outer* with Pop-up Color Command+Select Color —
Fill Outer* with Extracted Color Command+Eyedropper+Click —
Fill Part* with Paint Color Option+Paint Bucket+Click Control+Paint Bucket+Click
Toggle Show/Hide Outline Command+H Control+H
Resize from Center Resize tool+Option+Drag Resize tool+Control+Drag
Constrain Reshape to Horizontal/Vert Resize tool+SHIFT+Drag Resize tool+SHIFT+Drag

Function Performed Macintosh Windows

PhotoEffects  (PhotoCastShadow, PhotoButton, PhotoBevel/Emboss/Glow)



options   62-64
outer area, discussed   63, 66-67  
parts defined   66
positioning   69
shape

controls identified   64
manipulating   69
selecting   65-66, 73

size
locking   68
manipulating   69
specifying   65-66, 68

tools   62-64, 69-72
tutorial   73-76, 77-78

buttons, toolbar
adding   14
adding space between   13
creating new

Macintosh   16-20
Windows   23

finding in library   14
for Finder Items, Macintosh   19
for Keystrokes

Macintosh   17
Windows   23

for Menu Items
Macintosh   16
Windows   23

for Plug-ins and Filters
Macintosh   16
Windows   23

icons, creating your own
Macintosh   22
Windows   24

rearranging   13
removing   12
repositioning   13

C
Cancel command   38, 40, 53, 59, 60, 61, 62
Cast Shadow Preset   58
Cast shadows   54-56, 58
categories of toolbars, discussed   14-15
Character width controls   25, 26, 31
Clipboard, using to create icons   22, 24
Color Modes   50
Color Palette

for Text   25, 26, 32
for Effects   47, 53, 57, 59, 60, 61
for Button   62, 70-71

Color tab in PhotoButton   62-63
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3-D buttons, creating   65-72, 73-77
3-D shadow effects, creating   54-58

A
Actions Palette Awareness   36, 50
Actions Palette Scripting   50
Add Styles See also “Style Settings”
Adding 

button icons, Macintosh   22
button icons, Windows   24
buttons to a toolbar   14

Adding text   See “Text, adding”
Additional Information about effects   48-52
Adjustment tool

for buttons   69
for shadows   54-56

Anchor button   65
Anti-alias   25, 26

when to use (Tip)   28
Apply command

text   25, 26, 30
effect   37-38, 40, 53, 59, 60, 61, 62
keyboard shortcut   79, 80

B
Background processing   44
Bevel   See also “PhotoButton,” “PhotoBevel”

button part, discussed   66-67
button part, coloring   70-72
Curve, of button   64
Effect, types   59
Height, of button   64
tab described   63
Width, of button   64
Width, of Effect   59

Blend Mode
PhotoCastShadow   53, 57
PhotoGlow   61
unexpected results with   52

Blur control   53
Button    See also “buttons, toolbar”

Adding Text and Glows to   77
Anchor   65
bevel part, discussed   63, 64, 66-67
Color   70-72
color modifier keys   71, 80
Creating Your Own   73
inner part, discussed   63, 66-67
matrix   65-66
number, specifying   65-66, 68, 73

Index



Color tools 
for PhotoButton   62-63, 70-72
for PhotoEffects   See “Color Palette”

Composite Layers
creating, for text (Tip)   27
for Effects   42

Composite preview   See “Composite Layers”
Control knob

for adjusting button highlight color   72
Copy text from another application   28
Corner Radius, of button   64, 69
Create Glow Only   61

discussed   49, 57
Create Shadow Only   53

discussed   49, 57
Creating New Buttons

for Macintosh toolbars   16-22
for Windows toolbars   23

Cursor coordinates, for text   25, 26
Customize toolbars   12-15

dialog box   14, 15
Cutout 

shadow Preset   58
effect   57

D
Define Icons dialog box   16
Diffuse Angle   63, 72
Direction

of Highlight   72
of Shadow   53

Distort
button   69
shadow   54-56

Drop Shadow Preset   58
Drop shadows, creating   55, 58

E
Edit Custom Button dialog box   17
Edge Tolerance, of Bevel   59
Effects   See specific effect (e.g. “PhotoGlow”)
Effects, common elements   36-47
Effect Settings

deleting   39
Presets   39, 58, 59, 60, 61, 62, 63
saving   38
using   39

embedded toolbar   See “toolbars, embedded”
Emboss effect   37, 60
Explicit selection   44
Eyedropper tool   36, 53, 59, 60, 61, 62

interactive previewing with   47
using, common effects   47
using, PhotoButton   71

F
Files, adding to toolbar (Macintosh)   15, 19
Fit on Preview command   36, 42, 80
floating palette   See “toolbars, floating”
Floating selections, discussed (Tip)   37
floating toolbar   See “toolbars, floating”
Font

tools   25, 26, 28, 32-34
menu   31

G
Glow effect   37, 61
Glow Diffusion   61

H
Handles

for Button resizing   69, 66-69
for Shadow resizing   54-56

Help Box   36, 40, 53, 59, 60, 61, 62
Highlight

and shadow intensity controls   59, 60
directional controls   59, 60, 72
Inclination   62, 72
Ratio   63, 72

Highlight Ratio   63, 72
Hot Help   10   See also “Help Box”

I
Icon Button Editor   23
icons   See “buttons, toolbar > icons”
Image Area of button matrix, defined   65  
Image navigator   46
Implicit selection   44
Inclination, of highlight color   62, 72
Inner button part   See also “Buttons”

See also “PhotoButton”
coloring   70-72
discussed   66-67
tab   63

Inner Height, of button   64
Interactive wireframe

for Buttons   66, 69
for Shadows   54

Invert
effect discussed  57
Selection command  53, 60  

K
Kerning controls   25, 26, 31
Keyboard commands, creating buttons for

Macintosh   17
Windows   23-24

Keyboard shortcuts, listed   79, 80

82



Preview window   59
tools, common   37-47
tools, specific   59

PhotoButton   62-78   See also “Buttons”
Getting Started with   65-68
Preview window   62
tools, common   37-47
tools, specific   62-64, 68-69

PhotoCastShadow   53-58   See also “Shadows”
Getting Started with   54
Preview window   53
tools, common   37-47
tools, specific   54-58

PhotoEffects Plug-ins  35-52   
See also specific effects (e.g. “PhotoGlow”)
common elements listed   36
common elements explained   40-52  
defined   35
effect Settings   38-39
Preview window   40

PhotoEmboss
creating effects   37
Preview window   60
tools, common   37-47
tools, specific   60

PhotoGlow   61
creating effects   37
Preview window   61
tools, common   37-47
tools, specific   61

PhotoText   25-34
menus   31
Preview window, Macintosh   26
Preview window, Windows   25
tools   25, 26
using   27-34

PhotoTools, overview   7-8
Pixels

in PhotoButton   64, 65, 68, 73
toolbar button icon size   22, 24

Plug-ins
one-click access   See “buttons, toolbars”
PhotoEffects   See “PhotoEffects Plug-ins”

Pop-up
See “Color Palette,” “Navigator”

Positioning 
Buttons   69
Shadows   54
text   25, 26
toolbars   11-12
toolbar buttons   12-13

Presets   38-39, 58
Preview window   See specific effect
Progress bar

Background processing   44
Preview processing   43

L
Last Used Preset discussed   54
Layers

viewing, in text   27
viewing, in Effects   42
unexpected results with   48, 49, 57

Leading controls   25, 26, 31
Light Direction

Field and Indicator   59, 60
of Highlight   See “Highlight”

Lock button size   68

M
“Marching ants” selections   44   
Matrix of buttons, defined   65, 66
Modes, color   50
Move tool

for Text   25, 26
for Buttons   69
for Shadows   54

Multiple layers   See “View Composite Layers”
Multiple undos   36, 40, 41, 50

N
Navigating windows   25, 26, 45-46, 79, 80
Navigator pop-up

discussed   36, 46
using   46

Navigator, Preview   46
Neon effect   61
No Highlighting command 63, 70, 72
None, color choice   63, 70
Number of buttons, specifying   64, 65-66, 68, 73

O
Opacity   61
Outer button area   See also “Buttons”

See also “PhotoButton”
coloring   71
discussed   66-67
tab   63

P
Paint Color, of buttons   62, 63, 70-72
Paint Bucket, using, to color buttons   71
Panning

how to   46
keyboard shortcuts   79, 80

Perspective Blur   53
PhotoBars   9-24   See also “buttons, toolbars”
PhotoBevel   59

creating effects   37
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R
Radiance   
RAM Memory and multiple undos   50
Real-time Preview   44
Redo   41
Reset   41, 57
Reshape and Resize tools

for Buttons   62, 69
for Shadows   53, 54-56

Rotation angle
of Buttons   64
of Shadow   53

S
Save text blocks command   25, 26, 29
Scroll

how to   46
keyboard shortcuts   79, 80

Settings
See “Effect Settings”
See “Style Settings, for text”

Shadow Frame explained   54
Shadows 57, 58, 54-56
Shape controls

for Buttons   62-64, 65, 68-69 
for Shadows   53, 54-56

Shapes, of Button   64, 66
Shape tab, PhotoButton   64
Sizeof Button, specifying   65-66, 68
SmartBar, creating toolbars with   20-21
Spacing

Menu, text   31
of Buttons, discussed   65-69
toolbar buttons, how to   13

Style Settings, for text   32-34
S u r face Pro p e rty Contro l s , of bu t t o n 63, 70-71, 72
Surface Property tabs   63
Surface Reflectivity   63, 72

T
Text

adding, from a saved text block   29-30
adding, from another application   28
Apply command   25, 26, 30
Saved Text Blocks   See “Text blocks, saving”
Styles   32-33
tools   25, 26, 28, 31-32

Text blocks
opening   29-30
re-editing   29-30
saving   29, 30

toolbar buttons See “buttons, toolbar”

toolbars
accessing files and folders   19
buttons, adding   14
categories of, accessing   14-15
changing from embedded to floating   12
changing from floating to embedded   11
customizing   12-15
embedded   11
floating   11
Hot Help, for toolbars   10
new, creating   13
Showing/Hiding   10-11
ToolTips, for toolbars   10

ToolTips, for toolbars   10
Track/Kern controls   25, 26, 31
Tracking controls 25, 26, 31
Transparent

color, described   70
layers discussed   42, 44, 51

U
Undo

a command, how to
multiple

Unexpected Results
Unlock button size

V
Virtual Memory discussed   50

W
Watch Me button   20
Width controls

for Buttons   64, 65-66
for text   25, 26, 31

Window Navigator   46

X, Y, Z
X Offset, of Shadow   53, 54-55
Y Offset, of Shadow   53, 54-55
Zoom

how to   45
keyboard shortcuts   79, 80
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Registration

If you haven’t already registered, please complete the following regis-
tration information, tear along the perforation and fax to (503) 274-
0530 or drop it in the mail in the postage-paid envelope provided. Your
product registration number is located on the back of your manual.

■■■-■■■-■■■-■■■-■■■-■■■

Name

Organization

Street Address

City State Country Zip/Postal Code

Daytime Phone Daytime Fax

e-mail (optional) 

Platform (check all that apply)

■ Macintosh          ■ Wi n d ows            ■ Other _________________

Applications Used (check all that apply)

■ Q u a rk X P ress        ■ Page M a ker        ■ Photoshop        ■ I l l u s t rator       ■ Fre e H a n d
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Suggestion

We’d like to know what you think we could do to make Extensis
PhotoTools better. So if you have an idea for a new product feature, a
modification to an existing one, or anything else you can think of that
will help us make this product better—we’d like to hear from you.

To help make Extensis PhotoTools better, please...

1. Print your name, address, and phone number below and sign your 
name.

2. Describe your idea or comment.

3. Tear this page out and mail or fax this sheet to Extensis.

I understand that no compensation will be awarded for my suggestion.

My suggestion is…

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Name

Street Address

City State           Country                              Zip/Postal Code
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